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SpeechMiner Administration Guide
The SpeechMiner 8.5.2 Administration Guide provides the instructions required to install and
configure the SpeechMiner components. These pages are valid for all 8.5.2 releases of
SpeechMiner. See the summary of the highlighted topics below:

About SpeechMiner

Find out about SpeechMiner:

Introduction
New in this Release

Installation and Configuration

Find out about how to deploy the components:

SpeechMiner Components
Installing SpeechMiner
Configuring SpeechMiner

SpeechMiner Administration Guide

Admin Guide 3



Introduction
SpeechMiner , Genesys Telecommunications Laboratories’s speech-analytics platform
analyzes call content as well as text-based interactions such as e-mails and chats. Speech-
analytics leverages recorded customer interactions (from any recording system) and
analyzes each interaction for critical business topics and events. With unmatched accuracy,
the system "listens" to conversations between customers and contact-center agents,
precisely identifies the topics that were discussed, and categorizes what took place within
each interaction.

SpeechMiner supports three modes of operation:

• Analytics and Recording UI: SpeechMiner plays back and analyzes interactions
recorded with Genesys Interaction Recording.

• Recording UI Only: SpeechMiner plays back the call audio for each interaction in
the search results. The contents of the interactions are not processed by the speech-
analytics system.

• Analytics Only: SpeechMiner imports interactions and their recorded call audio from
any recording system. Once the interactions and their audio is imported
SpeechMiner processes the contents of each interaction.

Important
If you have purchased both Recording and Analytics
licenses, it is recommended that you review the
specific SpeechMiner setup instructions in the
Genesys Interaction Recording documentation prior
to commencing with the installation procedure. There
may be some changes required to the generic
analytics procedures in this SpeechMiner
Administration Guide.

The SpeechMiner user interface is made up of two software components:

• SpeechMiner browser-based interface, Offers a variety of ways to access the
audio of calls and the results of the interaction analysis performed by the system
(when Analytics mode is in use). Users of the speech-analytics system can employ
this interface to:

◦ find interactions that have specific characteristics or that deal with particular
topics

Introduction
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◦ identify and listen to the parts of calls that interest them
◦ audit and fine-tune SpeechMiner's call processing
◦ keep track of a range of system-metrics.

• SpeechMiner Administration Tool (SMART), enables users of the speech-
analytics system to configure it to search interactions for specific topics and other
characteristics.

This manual explains how to install and configure SpeechMiner. It is intended for system
administrators. Most of the steps described are only performed once, usually with the help of
Genesys Customer Care.

New in this Release
This section describes the new features that were released in the 8.5.x version of
SpeechMiner.

8.5.2 Release
• New Responsive Style User Interface: In this release, the Main page, Menus, Media

Player, Search pages and grids have been updated with the new design.
• New Media Player with Video Playback Capability: The updated media player, now

supports screen recordings. When working with GIR, audio and screen recordings
can now be synchronized.

• Multiple QM Forms per Interaction: Multiple QM form evaluations can now be
attached to a single interaction.

• Categorization Based on Spatial Relationships: Text interactions can now be
categorized based on rules such as: "found abc within X words of xyz.".

• Wildcard Support for Text Interaction Topic Definitions: Like Voice interaction topic
definitions, Text interaction topic definitions can now utilize wildcards.

• Recognition Improvements: Continuous recognition improvements were made in this
release based on new customer and vertical training material.

8.5.001 Release
• Ability to add text interactions to saved lists: Similar to voice interactions, text

interactions can now be added to saved lists.
• Ability to add comments to text interactions: Similar to voice interactions, comments

can now be added to text interactions.
• Ability to search for numbers in text interactions: Numbers and special characters

can now be used in search term definitions for text interactions.
• Events are displayed in text interactions: Similar to voice interactions, topic events

are highlighted when they occur in text interactions.

Introduction New in this Release
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• Topic filters in reports supports text interactions: The topic parameter in the Data Set
Filters on the reports now works for text interactions.

• Support for wildcards in Spanish: Similar to English, wildcards are now supported for
Spanish voice interactions.

• High Availability improvement for indexing: In the event of an index failure, the
system will automatically switch to a backup index.

8.5.0 Release
• Interaction Recording Integration: SpeechMiner 8.5.x provides the UI for Genesys

Interaction Recording - Voice Edition. This enables out of the box integration with
Genesys’ new recording product.

• Chrome Support: Support for Chrome on Windows for the Interaction Recording
features.

• Chat Support: Support for chat interactions with multiple speakers.
• Genesys Branding: The web UI has been re-branded with the Genesys name, logos

and colors.
• Configuration Server Integration: SpeechMiner now integrates with Genesys

Configuration Server for centralized user management.
• Language Recognition Support: Support for Brazilian Portuguese and German

language calls.

Introduction New in this Release
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Deploying SpeechMiner
This section describes the SpeechMiner system and how to configure each component for
your enterprise.

Components

SpeechMiner Components
The SpeechMiner system makes use of the following components:

• UPlatform service—Manages all the processing tasks of SpeechMiner—fetching (in
the case of Analytics mode), recognition and exploration (in the case of Analytics and
Analytics & Recording UI modes), categorization compression, and indexing (in all
modes).

• Recognition engine—Nuance speech-recognition engine that transcribes call audio
into text.

• Nuance License Server— This server manages the Nuance engine. During
installation, you need to either install a new instance of the Nuance License server,
or provide the details of an existing server.

• UConnector service—Retrieves interaction data (audio or text) and metadata from
the recording systems that is placed in the SpeechMiner input folder.

• Interaction Receiver—A web service which receives calls (audio and metadata)
from the Genesys Interaction Recording system.

• MS-SQL database—The SpeechMiner database stores the interaction data and the
results of interaction processing.

• Web service—Runs the SpeechMiner web-based interface that enables users to
view and work with the interaction data after it has been processed.

• ULogger—The log viewer for the SpeechMiner logs.

System Software
Users employ the following software to work with SpeechMiner:

• SpeechMiner browser-based interface—Offers a variety of ways to access the
audio of calls and the results of the interaction analysis performed by the system
(when Analytics mode is in use). Users of the speech-analytics system can employ
this interface to:

◦ find interactions that have specific characteristics or that deal with particular
topics

◦ identify and listen to the parts of calls that interest them

Deploying SpeechMiner New in this Release
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◦ audit and fine-tune SpeechMiner's call processing
◦ keep track of a range of system-metrics.

• SpeechMiner administration tool (SMART)—An application that enables users to
configure the speech-analytics system to search calls for specific topics and other
characteristics.

• SMConfig—An application that is used by system administrators to configure
SpeechMiner.

• SMUpgrade—An application used to upgrade the SpeechMiner database from the
previous version to current version. For additional information refer to the
SpeechMiner Upgrade Guide.

Install

Installing SpeechMiner
This section explains how to install SpeechMiner at your enterprise. This section includes
pre-installation steps; setting up the system components, database, and the software steps
that users employ to interact with the system. The components can be installed on a single
machine, or on separate machines, as required by the particular configuration of your
system.

Configure

Configuring SpeechMiner
This section explains how to configure SpeechMiner after it is installed. Most of the
configuration is performed in the SMConfig application. This is a Windows application that
can be installed on any machine on your network. Once it is installed, it can be used, from
any machine on which it is installed, to configure the entire SpeechMiner system.

Installing SpeechMiner
This section describes how to prepare your environment before you install SpeechMiner,
and how to install the SpeechMiner software. The SpeechMiner components can be
installed on one or more servers, as required by the particular configuration of your system.

Deploying SpeechMiner Installing SpeechMiner
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Important
Since the SpeechMiner supported environment may
be different for each SpeechMiner version, the
current SpeechMiner Administration Guide may
contain information that does not apply to your
version of SpeechMiner. For detailed information
about supported operating environments, see the
Supported Operating Environment Reference Guide.

Getting Started
Before you install SpeechMiner, make sure of the following:

• The system requirements are met.
• The required third-party software has been installed on the machines in your system.
• The required permissions are set.

Then, review the Pre-installation Checklist before you begin the installation process.

System Requirements

Disk Space
Each server in the system should have at least the following amounts of available disk space
before installing SpeechMiner:

• All servers: Approximately 1 GB of disk space for the recognition engine
• Recognition server(s): For the UPlatform service, 20 MB of disk space for the

runtime folder plus approximately 10 GB for caching recognition packages. (The
exact amount required for caching depends on the size of the implementation.)

• Database server: At least 20 GB for the SpeechMiner database. In addition, on
some types of recording-system integrations that have a very high volume, a larger
(10 GB-200 GB) storage area is needed for temporary files.

Important

Deploying SpeechMiner Installing SpeechMiner
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• The initial size of the database is about 20
GB; it may grow larger, depending on the call
volume and the call-purging policy.

• On relatively high-volume installations,
UConnector may need its own dedicated
server.

• Web server: About 20 MB for the SpeechMiner virtual folder, plus additional space
for call audio. (The exact amount required for caching depends on user activity.)

• Interaction Receiver: About 15 MB for the Interaction Receiver virtual folder.
• Machines running SMART: About 1 GB of disk space for the recognition engine

Database
The database must run on a machine on which one of the following SQL servers is installed:

• Microsoft SQL Server 2008 with Reporting Services, SP1 or above (Enterprise
edition is recommended for large installations.)

• Microsoft SQL Server 2012 with Reporting Services

Operating Systems
All machines must have Windows operating systems.
For detailed information about the Windows operating systems that are compatible with each
SpeechMiner component refer to Supported Operating Environment Reference Guide.

Browser
The SpeechMiner web interface is compatible with Google Chrome and Internet Explorer
(IE) versions 10 and 11.

Users of the SpeechMiner web application must have a functioning audio device on their
desktop. Users browsing using Internet Explorer should have Windows Media Player version
10 or 11 installed.

Deploying SpeechMiner Installing SpeechMiner
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Memory (RAM)
Machines running SpeechMiner servers and applications should have at least the following
amounts of memory:

• Database server: 4 GB - 128 GB (dependent on call volume)
• Web server: 4 GB
• SMART application: 2 GB
• Platform server: 8 GB (allow 1 GB per recognizer task, as a rule of thumb)

What Is Installed?
The following software will be installed on the machines in your system:

Machine Components
On All Servers • MS .NET Framework 4.5.1 with SP1 (aka 4.5.1)
On the Recognition
Server(s)

• UPlatform service
• Nuance recognition engine

On the DB Server

• MS-SQL 2008 or 2012 Server, including MS Reporting
Services (normally installed by the customer beforehand)

• SpeechMiner database
• UConnector service (when not working with GIR).

On the Web Server • SpeechMiner virtual folder
On the Interaction
Receiver Server • Interaction Receiver virtual folder

On Every Machine
Running SMART

• Recognition engine
• SMART executable and runtime files (dlls)

Ports Used by the System Components
The following ports are used by SpeechMiner:

Important
The ports listed are the default ports. Most of them
can be changed upon request.

Source Destination Protocol and Port Pair
(ex. TCP 3389)

Deploying SpeechMiner Installing SpeechMiner
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Web servers, Platform servers, SpeechMiner
Administrator Workstations (SMConfig/
SMART)

Database
server tcp 1433

Database server, Web server, Platform
servers, SpeechMiner Administrator
Workstations (SMConfig/SMART)

MS-SQL
report server http 80 / https 443

SpeechMiner Administrator Workstations
(SMConfig/SMART) Web servers http 80 / https 443

Genesys Interaction Recording server
Interaction
Receiver
Server

http 80 / https 443

Web Servers Web servers http 80 / https 443

SpeechMiner Administrator Workstations
(SMConfig)

Platform
servers, Web
servers

tcp 135

Platform servers (recognition), SpeechMiner
Administrator Workstations (SMART)

SpeechMiner
Nuance
License server

tcp 27000 + another
port (can be configured
in license file)

Web servers, Platform servers, SpeechMiner
Administrator Workstations (SMConfig/
SMART)

File System smtp over tcp 445

Web servers, SpeechMiner Administrator
Workstations (SMConfig/SMART)

Active
Directory tcp 88

Web servers, Platform servers Email server smtp over tcp 25

Ports and Protocols Required for SpeechMiner UConnector

SpeechMiner UConnector requires access to the recording-system database and file-
storage system. Access to the database is implemented using the TCP protocol with port
1433. (The port number can be configured on the database server.) Access to the file-
storage system is implemented using SMB over TCP protocol with port 445. Other protocols
can be used as well, if they are available in the underlying file-storage system.

Required Third-Party Software
This section explains how to install the required third-party software on the machines in your
system.

Deploying SpeechMiner Installing SpeechMiner
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Tip
You should install the required software before you
install SpeechMiner.

.NET Framework

Installing the .NET Framework

Microsoft .NET Framework 4.5 SP1 (4.5.1) and .NET 2.0 must be installed on all machines
that will run SpeechMiner components or interact with SpeechMiner

If you are installing the .NET Framework on machines that are running Windows Server
2008 R2 or Windows Server 2012:

• Enable .NET framework using the Add Features option in the Server Manager (Start
> Administrative Tools > Server Manager).

• Verify that Windows Update is enabled.

If Windows Update is not enabled or you are using an operating system other than Windows
Server 2008 R2 or Windows Server 2012, manually download and install .NET 4.5.1 from
the following location: http://www.microsoft.com/en-us/download/details.aspx?id=40779

Microsoft Visual C++ 2013 Redistributable

Installing Microsoft Visual C++ 2013 Redistributable

Microsoft Visual C++ 2013 Redistributable must be installed on all machines that will run
SpeechMiner components or interact with SpeechMiner. You can download the installation
package at http://www.microsoft.com/en-us/download/details.aspx?id=40784.

Important
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When installing Microsoft Visual C++ 2013
Redistributable on a 64 operating system you must
install both 86 and 64 versions. When installing on a
32 operating system you must install the 86 version.

SQL Server

Setting Up the SQL Server

Before you begin installing SpeechMiner, you must install the SQL server on the database
server. You can use either Microsoft SQL Server 2008 with Reporting Services or Microsoft
SQL Server 2012 with Reporting Services.

For information about installing and configuring the SQL Server for SpeechMiner, see
Setting Up the SQL Server for SpeechMiner.

Internet Information Server

Installing IIS on the Web Server or Interaction Receiver Server

The Internet Information Server (IIS) must be installed and operational on the servers that
will be used to run the SpeechMiner Web and the Interaction Receiver. You can install and
configure:

• Windows Server 2008
• Windows Server 2012

Notes:

• The SpeechMiner and Interaction Receiver Application Pool must use .NET
framework version 4.0. After you install the SpeechMiner web server, you should
check that this is the version in use.

• It is recommended to enable HTTP Compression on the IIS server. For additional
information, see http://technet.microsoft.com/en-us/library/cc771003(v=ws.10).aspx.

Report Viewer

Deploying SpeechMiner Installing SpeechMiner
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Installing Report Viewer

SpeechMiner can be configured to use Microsoft's Report Viewer to run saved reports at
night and cache their results. Using Microsoft's Report Viewer can significantly reduce the
time required to load the SpeechMiner Views page, if it contains a large number of reports.
If you want to use this feature, you have to install it and then configure it to run the jobs you
want it to run. You can download the installation file at http://www.microsoft.com/en-us/
download/details.aspx?id=21916.

For additional information about Report Caching see: Defining Caching Reports

Setting Up the SQL Server for SpeechMiner

Installing SQL Server 2008 R2
In order to install SQL Server 2008 R2 for use with SpeechMiner, run the normal setup
wizard and follow the instructions. To install SQL Server 2008 R2:

1. Run the installation program. The SQL Server Installation Center window opens,
with the Planning screen open.

Deploying SpeechMiner Installing SpeechMiner
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2. From the menu on the left, select Installation. The Installation screen opens.

3. Select New installation or add features to an existing installation. The
installation wizard opens.

4. Follow the on-screen instructions. When the screens mentioned below open, follow
the instructions below to select the required settings and options for SpeechMiner.

Deploying SpeechMiner Installing SpeechMiner
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5. From the Setup Role screen, select SQL Server Feature Installation.

6. From the Feature Selection screen, select the following options:
◦ Database Engine Services
◦ Reporting Services
◦ Client Tools Connectivity
◦ SQL Server Books Online
◦ Management Tools Basic
◦ Management Tools Complete

Deploying SpeechMiner Installing SpeechMiner
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7. From the Server Configuration screen, in the Service Accounts tab, for the SQL
Server Agent, SQL Server Database Engine, and SQL Server Reporting
Services, do the following:

◦ Enter the user account and password of the service account.
◦ Under Startup Type, select Automatic.

Deploying SpeechMiner Installing SpeechMiner
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8. From the Server Configuration screen, in the Collation tab, under Database
Engine, select SQL_Latin1_General_CP1_CI_AS (the default value).

9. From the Database Engine Configuration screen, in the Data Directories tab,
select the locations for the database folders. If possible, put the User database
directory, the Temp DB directory, and the Backup directory on a separate drive from

Deploying SpeechMiner Installing SpeechMiner
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the other folders.

10. From the Reporting Services Configuration screen, select Install the native
mode default configuration.

11. When you finish installing the SQL Server, restart the machine on which you installed
it.

Installing SQL Server 2012
In order to install SQL Server 2012 for use with SpeechMiner, run the normal setup wizard
and follow the instructions. To install SQL Server 2012:

1. Run the installation program. The SQL Server Installation Center window opens,
with the Planning screen open.

2. From the menu on the left, select Installation. The Installation screen opens. Select
New installation or add features to an existing installation. The installation
wizard opens.

Deploying SpeechMiner Installing SpeechMiner

Admin Guide 21



3. Follow the on-screen instructions. When the screens mentioned below open, follow
the instructions below to select the required settings and options for SpeechMiner.

4. From the Setup Role screen, select SQL Server Feature Installation.
5. From the Feature Selection screen, select the following options:

◦ Database Engine Services
◦ Reporting Services
◦ Client Tools Connectivity
◦ SQL Server Books Online
◦ Management Tools Basic
◦ Management Tools Complete

Deploying SpeechMiner Installing SpeechMiner
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6. From the Server Configuration screen, in the Service Accounts tab, for the SQL
Server Agent, SQL Server Database Engine, and SQL Server Reporting
Services, do the following:

◦ Enter the user account and password of the service account.
◦ Under Startup Type, select Automatic.

Deploying SpeechMiner Installing SpeechMiner
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7. From the Server Configuration screen, in the Collation tab, under Database
Engine, select SQL_Latin1_General_CP1_CI_AS (the default value).

8. From the Database Engine Configuration screen, in the Data Directories tab,
select the locations for the database folders. If possible, put the User database
directory, the Temp DB directory, and the Backup directory on a separate drive from
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the other folders.

9. From the Reporting Services Configuration screen, select Install the native
mode default configuration.

10. When you finish installing the SQL Server, restart the machine on which you installed
it.

Configuring the SQL Server Setting
After the SQL server is installed, do the following:

• Ensure that the SQL server is running
• Configure the SQL server to start automatically
• Enable both the TCP/IP and the Named Pipes protocols

Deploying SpeechMiner Installing SpeechMiner
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Important
After you install SpeechMiner, you also have to
deploy the CLR assembly and set its permissions.
See Installing the SpeechMiner Components >
Installing the SpeechMiner Database > SQL CLR.

To configure the SQL server and enable the required protocols:

1. From the Start menu, navigate to Microsoft SQL Server 2008 > Configuration
Tools > SQL Server Configuration Manager. The SQL Server Configuration
Manager opens.

2. On the left side of the window, select SQL Server Services.

3. On the right side of the window, for SQL Server Agent, check that the Status is
Running, and the Start Mode is Automatic.

4. If one or both of these values are not as they should be, do the following:
◦ Double-click the row. The Properties window opens.
◦ In the Service tab, set the Start Mode to Automatic.
◦ If the service is not running, in the Log On tab, select Start.
◦ Click OK to implement the changes.

Deploying SpeechMiner Installing SpeechMiner
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5. On the left side of the SQL Server Configuration Manager window, select SQL
Server Network Configuration > Protocols for MSSQLSERVER.

6. On the right side of the window, for TCP/IP and for Named Pipes, check that the
Status is Enabled.

7. For each of these protocols, if it is not enabled, do the following:
◦ Double-click the row. The Properties window opens.
◦ In the Protocol tab, under Enabled, select Yes.
◦ Click OK to implement the changes.

Configuring the Reporting Services
The SQL reporting services should be configured as explained below. To configure the SQL
reporting services:

1. In the Start menu, under All Programs, select SQL Server 2008 R2 >
Configuration Tools > Reporting Services Configuration Manager. The
Reporting Services Configuration Connections window opens.

2. Enter the report server name and the instance name (if they are not already there),
and click Connect. The Reporting Services Configuration Manager opens, with
the Report Server Status screen displayed.
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3. Check whether the report server is running. If it is not, click Start.
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4. On the left side of the window, select Service Account.

5. Configure the account name and password of the service account that will be used to
run the report-server service, as required. Use either a local administrator account or
an account that can log in as a service and run services on the local machine.

The user must be a Domain user.

6. On the left side of the window, select Web Service URL; make sure the settings in
the screen match the settings as follows:
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7. On the left side of the window, select Database. If you created a report-server
database when you installed SQL Server, it appears under Current Report Server
Database. If you did not, create it now.
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8. On the left side of the window, select Report Manager URL; make sure the settings
in the screen match the settings as follows:
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9. On the left side of the window, select E-mail Settings.
10. Enter the settings for the e-mail account you want the report server to use to send

reports to SpeechMiner users.
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11. Click Exit to close the Reporting Services Configuration Manager.
12. In the Report Server config file (rsreportserver.config) change the

MaxActiveReqForOneUser parameter value from 20 to 250.
For more details see: http://msdn.microsoft.com/en-us/library/ms157273.aspx

Creating the Report-Server Database
If the report-server database was not created automatically when you installed SQL Server,
you can create it in the Report Server Database Configuration Wizard. To create the
report-server database:

1. Open the Reporting Services Configuration Manager.
2. From the Database screen, under Current Report Server Database, click Change

Database. The Report Server Database Configuration Wizard opens.
3. In the wizard, fill in the fields as they are filled in in the examples shown (except, of

course, for the server name and the credentials, which you must specify as
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appropriate for your system). Click Next to progress from screen to screen until you
have finished creating the database.

Action Database Server Database Credentials

Click on the image to enlarge.

Setting the Maximum Memory Usage
If the SQL-server's memory usage is not limited, it will consume all of the available memory.
Therefore, it is recommended to limit the memory usage of the SQL Server by setting the
max server memory value.

Important
In addition to the "server memory" that is limited by
this value, the SQL server uses 2-4 GB of other
memory. For this reason, it is recommended to set
the max server memory to a value that is 2-4 GB
lower than the maximum memory you want to allow
the server to use. For additional details, see
http://msdn.microsoft.com/en-us/library/
ms178067.aspx.

You can see the current max server memory value, and modify it as required, in the SQL
Server Management Studio.

To view or modify the max server memory value:
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1. From the SQL server, open the SQL Server Management Studio. (For example, in
the Start menu, under All Programs, select Microsoft SQL Server 2008 R2 > SQL
Server Management Studio.)

2. On the left side of the window, right-click the SQL server and then select Properties.
The Server Properties window opens.

3. On the left side of the window, select Memory. The memory settings are displayed.
4. Under Maximum server memory (in MB), enter the value you want to use.
5. Click OK. The setting is implemented, and the window closes.

If you prefer, you can also set the max server memory property by executing a query:

To set the max server memory by executing a query:
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1. On the SQL server, open the SQL Server Management Studio. (For example, in
the Start menu, under All Programs, select Microsoft SQL Server 2008 R2 > SQL
Server Management Studio.)

2. On the left side of the window, right-click the SQL server and then select New
Query. A blank text area opens on the right side of the window.

3. Copy the following commands and paste them into the text area:

sp_configure 'show advanced options', 1;
GO
RECONFIGURE;
GO
sp_configure 'max server memory', 4096;
GO
RECONFIGURE;
GO

4. The code sets the max server memory to 4GB (4096MB). If you want to set it to a
different value, in the text area, change 4096 to the required value.

5. Above the text area, select Execute. The commands are executed. When the
process is completed successfully, Query executed successfully appears at the
bottom of the window.
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Installing IIS on the Web Server or Interaction Receiver Server

Windows Server 2008

On Windows Server 2008, you can install and configure the Internet Information Services
(IIS) in the Server Manager.

To install and configure the IIS component:

1. From the Start menu, select All Programs > Administrative Tools > Server
Manager. The Server Manager opens.

2. On the left side of the window, select Roles.
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3. On the right side of the screen, select Add Roles. The Add Roles Wizard opens.

4. From the list of roles, select Web Server (IIS), and then select Next. An
Introduction to the Web Server is displayed.
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5. Select Next. The Role Services screen opens.

6. Under Role Services, make sure the following services are selected:
a. Under Common HTTP Features:

▪ Static Content
▪ Default Document
▪ Directory Browsing
▪ HTTP Errors
▪ HTTP Redirection

b. Under Application Development:
▪ ASP.NET
▪ ISAPI Extensions
▪ ISAPI Filters

Important
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When you select ASP.NET, a window pops
up, asking you to confirm that you want to
"Add role services required for ASP.NET."
Select Add required role services.

c. Under Security:
▪ Windows Authentication

d. Under IIS 6 Management Compatibility:
▪ IIS 6 WMI Compatibility
▪ IIS 6 Metabase Compatibility

7. Click Next. A Confirm Installation Selections screen opens.

8. Select Install. The installation process begins, and the Installation Progress screen
is displayed. When the installation is completed, an Installation Results screen is
displayed.
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9. Click Close. The Add Roles Wizard closes, and the Server Manager lists the Web
Server (IIS) role as installed.
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10. From the Server Manager, in the left pane, select Features, and then, in the right
pane, select Add Features. The Add Features Wizard opens.

11. From the list of features, expand the Background Intelligent Transfer Service
(BITS), and then select IIS Server Extension. A window pops up, asking you to
confirm that you want to Add role services required for IIS Server Extension.
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12. Select Add required role services. The window closes.
13. From the list of features, select SMTP Server. A window pops up, asking you to

confirm that you want to Add role services required for SMTP Server.
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14. Select Add required role services. The window closes.

Click Next three times, and then click Install. The installation process begins, and
the Installation Progress screen is displayed. When the installation is completed,
the Installation Results screen is displayed.
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15. Click Close. The Add Features Wizard closes, and the Server Manager lists the
features you selected as installed.

Windows Server 2012

On Windows Server 2012, you can install and configure the Internet Information Services
(IIS), version 8, in the Server Manager.

To install and configure the Internet Information Services (IIS) component:
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1. Open the Server Manager.

2. From the upper-right side of the window, in the Manage menu, select Add Roles
and Features. The Add Roles and Features Wizard opens.
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3. Select Include management tools (if applicable), and then select Next. The
Installation Type screen opens.

4. Select Role-based or feature-based installation, and then select Next. The Server
Selection screen opens.

5. Select the server on which you will be installing the SpeechMiner web server, and
then select Next. The Server Roles screen opens.

6. From the list of roles, select Web Server (IIS). A window pops up, and asks you to
confirm that you want to add the role services required for the web server.
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7. From the popup window, select Add Features. The pop-up window closes.
8. Select Next. The Features screen opens.
9. From the list of features, expand Background Intelligent Transfer Service, and

then select IIS Server Extention. A window pops up, and asks you to confirm that
you want to add the role services required for the IIS server extension.

10. From the popup window, select Add Features. The pop-up window closes.
11. From the list of features, select SMTP Server. A window pops up, and asks you to

confirm that you want to add the role services required for the SMTP server.
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12. From the popup window, select Add Features. The pop-up window closes.
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13. Select Next. The Role Services screen opens.

14. From the list of Role services, make sure the following services are selected:
a. Under Common HTTP Features:

▪ Static Content
▪ Default Document
▪ Directory Browsing
▪ HTTP Errors
▪ HTTP Redirection

b. Under Application Development:
▪ ASP.NET
▪ ASP.NET Extensibility
▪ ISAPI Extensions
▪ ISAPI Filters

c. Under Security:
▪ Windows Authentication

d. Under IIS Management tools:
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▪ IIS 6 Management Compatibility
▪ IIS Management Console

15. Select Next, and the select Install. The IIS server is installed with the roles and
features you selected.

Pre-installation Checklist
Before you begin installing SpeechMiner, ensure the following:

• You have the required hardware (see System Requirements).
• You have received the following from Genesys:

◦ SpeechMiner installation package
◦ Licenses

• Space check: The hard drives of the machines on which you are planning to install
the system components have sufficient space available for those components (see
System Requirements).

• OS check: All machines have supported operating systems (see System
Requirements).

• Machine connectivity: All machines are functional and connected to the network.
• Admin user: The user account that will be used to install the components has

Administrator permissions on all machines on which components will be installed.
• Verify that all of the following Required Third-Party Software is installed and

configured:
◦ .NET Framework
◦ SQL Server
◦ IIS installation
◦ Report Viewer

• Audio capabilities: Machines on which the SpeechMiner web application will run
have functioning audio devices, and Windows Media Player version 10 or 11
installed (see System Requirements).

Installing the SpeechMiner Components
The setup wizard is used to install all SpeechMiner components. You can run it separately
on each machine on which you are installing SpeechMiner components. If you are installing
multiple SpeechMiner components on the same machine, you can install them at the same
time. For example, if you are installing the database server and the web server on the same
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machine, you can select both of them in the setup wizard. In most systems, SMConfig is
installed on all server machines.

Installing Using the Wizard

Installing Using the Wizard
To install components using the setup wizard:

1. Open the installation package.
2. From the FullInstaller folder, run SpeechMinerInstall.exe. The setup wizard

opens, with the Welcome screen displayed.
3. Click Next. The License Agreement screen opens.
4. Select I accept the terms of the license agreement, and then click Next. The

Installation Type screen opens.
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5. Select the installation mode:
◦ Analytics and Recording UI: SpeechMiner plays back and analyzes

interactions recorded with Genesys Interaction Recording.
◦ Recording UI Only: SpeechMiner plays back the call audio for each

interaction in the search results. The contents of the interactions are not
processed by the speech-analytics system.

◦ Analytics Only: SpeechMiner imports interactions and their recorded call
audio from any recording system. Once the interactions and their audio is
imported SpeechMiner processes the contents of each interaction.

6. Click Next. The Choose Components screen opens.

7. In the list of components, select the components you want to install on the machine.
8. Click Next. Which screen you see next depends on the components you selected in

the previous screen.
◦ If you are installing the Uplatform, see Installing the UPlatform Server.
◦ If you are installing SMART, see Installing SMART.
◦ If you are installing the database, see Installing the SpeechMiner Database.
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◦ Otherwise, the Choose Install Location screen opens.

Important
By default, 64-bit SpeechMiner is installed in the
following location: C:\Program Files
(x86)\Genesys\Software.

9. Modify the default installation location if necessary, and then click Install. The
installation process begins. When the process is completed, the following screen
appears:
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10. Select Restart Now, and then click Finish. A warning message appears, and
reminds you to configure SpeechMiner before you open it.

11. Click OK. The server restarts.

Installing the SpeechMiner Database
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Installing the SpeechMiner Database
The SpeechMiner database stores the interaction data and the results of interaction
processing. It is usually installed on a dedicated machine. The following sections explain
how to install the SpeechMiner database.

Setup Wizard

Running the Setup Wizard

To begin the installation of the database server, run the setup wizard as described under
Installing the Components.

To install the database server:

1. On the database server machine, run the Setup Wizard, as described under Install
Using the wizard.
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2. Follow the instructions there, until the Database Credentials screen opens.

3. In the Database Credentials screen, fill in the fields as follows:

Field Description

Windows
Authenticated
User

Select this option to use the Windows username and password
you used to log into the machine as the DB User and DB
Password. When you select this option, the DB User and DB
Password become unavailable.

DB Server

Enter the name of the server on which you want to install the
SpeechMiner database. If you want to install the database on an
SQL Named Instance, the server name should be entered as
server_name\instance_name.

DB Name Enter the name of the database in the format
speechminer_verX_Y (for example, speechminer_ver8_5).

DB User Enter SA. (The credentials of the user name entered here will be
used for the process of creating the SpeechMiner database.)
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Note: This field is not available when Windows Authenticated
User is selected.

DB Password

Enter the DB password. Only a user with Administrator
permissions can enter password credentials.

Note: This field is not available when Windows Authenticated
User is selected.

4. Click Next. The Choose Install Location screen opens.
5. Modify the default installation location if necessary, and then click Install. The

installation process begins. When the process is completed select Restart Now, and
then click Finish. A warning message appears.

6. From the warning message, click OK. The server restarts.
7. After the database-server installation is completed, check that the

speechminer_verX_Y database is present. This can be done by opening SQL
Server Management Studio on the SQL server (for example, in the Start menu,
under All Programs, select Microsoft SQL Server 2008 R2 > SQL Server
Management Studio) and reviewing the list of databases on the server.
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Manual Installation

Manually Installing the SpeechMiner Database

An alternative way to perform the database installation is to use
data_ver8_5_3_sql2005.bak (an SQL backup file) deployed in C:\Program Files
(x86)\Genesys\Software\Support during any regular install. Restore this backup on the
SQL server and choose settings based on the settings in the steps above. After restoration
is complete, update the database properties as follows:

• For both the Data and Log files, change Options\Recovery Mode to Simple and
change the Files\Autogrowth\File Growth parameter to 10%.

• In addition, run the following commands to create the dbuser user:
◦ On the master database: create login [dbuser] with
password='dbuser',check_policy=OFF

◦ On the new database: EXEC sp_change_users_login 'Auto_Fix',
'dbuser'

Important
When you manually install the SpeechMiner
Database, you must run the database purge using
the SQL Server Service Broker.

To enable the SQL Server Service Broker:

1. Run the SP command: EXEC sp_enableServiceBroker

The SP will try to enable the service broker with ENABLE_BROKER. If it does not
succeed, it will run the command with NEW_BROKER. This SP will also use the current
DB name correctly.

2. If sp_enableServiceBroker does not enable the Service Broker, run the
following query:
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ALTER DATABASE [DB_NAME] SET ENABLE_BROKER WITH ROLLBACK
IMMEDIATE

3. Run the following query to verify that SQL Server Service Broker is enabled:

SELECT is_broker_enabled FROM sys.databases WHERE
database_id=DB_ID()

A value of 1 indicates that the Service Broker is enabled.

If the enable SQL Server Service Broker query fails:

1. Close all connections to the database.
2. Run the following query:

ALTER DATABASE [DB_NAME] SET ENABLE_BROKER WITH ROLLBACK
IMMEDIATE

3. Run the following query to verify that SQL Server Service Broker is enabled:
SELECT is_broker_enabled FROM sys.databases WHERE
database_id=DB_ID()

To disable the SQL Server Service Broker:

1. Run the following query:
ALTER DATABASE [DB_NAME] SET DISABLE_BROKER WITH ROLLBACK
IMMEDIATE

Default Database User

Change the Default Database User

If you want to change the default database user in SpeechMiner, you must assign the user
the rights required to access the relevant tables in the database. The UTOPY and Reports
roles give the user those rights. If you want to work with the pre-configured database user
(dbuser), or a user that already has full access (for example, an administrative user) you do
not need to assign the user new or different rights.
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To assign the default database user the correct roles:

1. Open the SQL Server Management Console.
2. In the new SpeechMiner Database folder select Security > Roles > Database

Roles.
3. Assign the UTOPY and Reports roles to the new default database user.

Storage Partitions

Creating the Storage Partitions

If the database server is an Enterprise Edition, you must create the storage partitions on the
database. To do this, after you install the database server, run the following SQL query on
the SpeechMiner database:

EXEC sp_create_DB_storage_partitions

Important
For information about how to open SQL Server
Management Studio and run a query, see Setting the
Maximum Memory Usage.

Maintenance Jobs

Configuring the Database Maintenance Jobs

When the database is installed, a database maintenance job
(SpeechMiner_Maintenance_job - <database>) is automatically created. You should
schedule it to run daily or weekly at a time when call volume is expected to be low. In
addition to scheduling the job to run, you can also modify it to suit your requirements.

By default, the maintenance job does the following:
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• Shuts down the SpeechMiner UPlatform service
• Rebuilds fragmented database table indexes
• Restarts the system
• Purges logs of messages that are older than one month
• Purges logs of user events that are older than one year
• Purges the report agent filter by removing entries that are older than 30 days and

creating a new list of agents

To open the maintenance-job script:

• From SQL Server Management Studio, under Databases > SQL Server Agent >
Jobs, double-click the job.
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The job may optionally include the updateUntilYesterdayMaxChannels and
sp_agentFilterCleanByDays jobs. In addition, any procedure that rebuilds indexes and
purges old calls should be added as a step in the maintenance job.

Important
If information about the agents and their hierarchy is
not available through the UConnector, you can
include the sp_createAgentsFromPartitions
job in this job.
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Changing the Job Owner

To enter change the job owner:

1. Open the SQL Management Tool.
2. Alter the Store procedure called sp_createMaintenanceJob.
3. In the following procedure text replace dbuser with an existing database user.

@owner_login_name=N'dbuser'

4. Execute the updated Store procedure to create the correct job.

SQL CLR

Deploying the SQL CLR

After you install the database, you should deploy the SQL Common Language Runtime
(CLR) assembly on the SQL server. To do this, on the Master, you must set the permissions
of the XmlSerializers.dll and enable xp_cmdshell and CLR integration, as
explained below.

Important
In order to set the permissions, the user running the
SQL services must have modify permissions on
sqlclr.XmlSerializers.dll.

To deploy the SQL CLR:

1. On the SQL server, open the SQL Server Management Studio. (For example, in
the Start menu, under All Programs, select Microsoft SQL Server 2008 R2 > SQL
Server Management Studio.)

2. On the left side of the window, right-click the SQL server and then select New
Query. A blank text area opens on the right side of the window.

3. Copy the following commands and paste them into the text area:

Deploying SpeechMiner Installing SpeechMiner

Admin Guide 65



use [master]
CREATE ASYMMETRIC KEY SQLCLRTestKey FROM EXECUTABLE FILE =
'\\<Machine_Name>\c$\Program Files (x86)\Genesys\Software\
Support\sqlclr.XmlSerializers.dll'
GO
use [master]
CREATE LOGIN SQLCLRTestLogin FROM ASYMMETRIC KEY SQLCLRTestKey
GO
use [master]
GRANT EXTERNAL ACCESS ASSEMBLY TO SQLCLRTestLogin

4. In the text area, change <Machine_Name> to the name of the machine on which the
SpeechMiner database was installed.

5. Above the text area, select Execute. The commands are executed. When the
process is completed successfully, Query executed successfully appears at the
bottom of the window.

Important
If you get an error message that says, "The
certificate, asymmetric key, or private key file
does not exist or has invalid format," try
changing the path to point at the local drive—for
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example, C:\Program Files
(x86)\Genesys\Software\Support\
sqlclr.XmlSerializers.dll.

6. Open another New Query.
7. Copy the following commands and paste them into the New Query text area:

EXEC sp_configure 'show advanced options', 1
GO
RECONFIGURE
GO
EXEC sp_configure 'clr_enabled', 1
GO
RECONFIGURE
GO

8. Above the text area, select Execute. The commands are executed. When the
process is completed successfully, xp_cmdshell and CLR integration are enabled,
and Query executed successfully appears at the bottom of the window.

9. Open another New Query.
10. Browse to C:\Program Files (x86)\Genesys\Software\Support.
11. Run the SQLCLR.sql script.

The clr assembly is created with EXTERNAL_ACCESS. To create an
EXTERNAL_ACCESS or UNSAFE assembly in SQL Server refer to:
http://msdn.microsoft.com/en-us/library/ms345106.aspx

Recovery Model

Configuring the Recovery Model

In order to save disk space, it is recommended to set the recovery model of the
SpeechMiner database to Simple.

Important
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If you use Log Shipping, set the recovery model to a
full or bulk-logged recovery model. Ensure that logs
are not written to the same hard drive as the
database files.

To set the recovery model to Simple:

1. On the SQL server, open the SQL Server Management Studio. (For example, in
the Start menu, under All Programs, select Microsoft SQL Server 2008 R2 > SQL
Server Management Studio.)

2. On the left side of the window, right-click the database and then select Properties.
The Database Properties window opens.

3. On the left side of the window, select Options.
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4. On the right side of the screen, under Recovery model, select Simple.

5. Click OK. The setting is implemented, and the window closes.

Autogrowth

Configuring the Autogrowth

Important
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It is recommended that you enable instant file
initialization. For details refer to:
http://msdn.microsoft.com/en-us/library/
ms175935.aspxshould

To modify the Autogrowth settings:

1. On the SQL server, open the SQL Server Management Studio. (For example, in
the Start menu, under All Programs, select Microsoft SQL Server 2008 R2 > SQL
Server Management Studio.)

2. On the left side of the window, right-click the database and then select Properties.
The Database Properties window opens.

3. On the left side of the window, select Files.
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4. On the right side of the screen select Autogrowth in the Data File row. The
Change Autogrowth dialog box opens.

5. Verify that Enable Autogrowth is selected.
6. Under File Growth, select Mega Types, and then, in the text box on the right enter

1024.
7. Click OK. The setting is changed in the Properties window.
8. On the right side of the screen select Autogrowth in the Log File row. The

Change Autogrowth dialog box opens.
9. Verify that Enable Autogrowth is selected.

10. Under File Growth, select Mega Types, and then, in the text box on the right enter
256.

11. Click OK. The setting is changed in the Properties window.
12. In the Properties window, click OK. The setting is implemented, and the window

closes.

QM Manager Role
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QM Manager Role Conflicts

When installing SpeechMiner, the following query should be run on all 8.5.3 databases to
avoid role ID conflicts with the new QM Manager role.

declare @QMRole int
select @QMRole=roleId from rolesTbl where roleName='QM Manager'
insert into rolesTbl select
20,roleName,internalRole,protectedRole,grantRoles,createdOn,createdBy,lastUpdate
from rolesTbl where roleId=@QMRole
update rolesTbl set grantRoles=REPLACE(grantRoles,CAST(@QMRole AS
varchar(10)),'20')
update rolePermissionsTbl set role=20 where role=@QMRole
delete rolesTbl where roleId=@QMRole

Installing the SpeechMiner Web

Installing the SpeechMiner Web
The SpeechMiner Web runs the interface to view and work with the interaction data after it
has been processed. You can install the web server on one or more machines in your
system, as required. To install the web server, run the Setup Wizard, as described under
Install Using the wizard.

Important
Once SpeechMiner is installed and configured, users
can open the web-based interfaces from their
browsers at
http://<webserver_name>/speechminer (where
<web server> is the name of a machine on which the
SpeechMiner is installed.

The SpeechMiner application pool uses v4.0 of the .Net framework. After you install the
SpeechMiner web server on a machine verify that the SpeechMiner Application Pool is
configured with:

• .Net Framework V4.0
• SMUSER account
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Configure the SpeechMiner Application Pool with .Net Framework V4.0

1. In the Start menu, select Administrative Tools > Internet Information Server (IIS)
Manager. The Internet Information Server (IIS) Manager opens.

2. In the left pane, expand the server name, and select Application Pools. The
currently defined application pools are listed in the middle pane.
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3. Under .NET Framework Version, check the version number listed for the
SpeechMiner application pool. If the number is 4.0, you do not have to make any
changes. If it is not, double-click the version number. The Edit Application Pool
dialog box opens.

4. Under .NET Framework version, select v4.0.

5. Click OK.

Configure the SpeechMiner Application Pool with a SMUSER Account

1. In the Start menu, select Administrative Tools > Internet Information Server (IIS)
Manager.

The Internet Information Server (IIS) Manager opens.

2. In the left pane, expand the server name, and select Application Pools.
3. Right click the SpeechMiner Application Pool and select Advanced Settings
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4. Under Process Model, change the Identity to SMUSER account.
5. Click OK.

Important
For additional details about the SMUSER account
refer to Configuring Permissions

Installing the Interaction Receiver

Installing the Interaction Receiver
The SpeechMiner Interaction Receiver runs the service that receives the calls (audio and
metadata) from the Genesys Interaction Recording system. To install the Interaction
Receiver, run the Setup Wizard, as described under Installing Using the Wizard.
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To allow Genesys Interaction Recording (GIR) to send a long audio file to SpeechMiner,
configure the Request Filtering Feature in the IIS server, as explained in http://www.iis.net/
configreference/system.webserver/security/requestfiltering/requestlimits, and set the
Maximum allowed content length to 345600000.

The Interaction Receiver application pool uses v4.0 of the .Net framework, and not a later
version. After you install the SpeechMiner web server on a machine verify that the
Interaction Receiver Application Pool is configured with:

• .Net Framework V4.0
• SMUSER account

Configure the SpeechMiner Application Pool with .Net Framework V4.0

1. In the Start menu, select Administrative Tools > Internet Information Server (IIS)
Manager. The Internet Information Server (IIS) Manager opens.

2. In the left pane, expand the server name, and select Application Pools. The
currently defined application pools are listed in the middle pane.
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3. Under .NET Framework Version, check the version number listed for the Interaction
Receiver application pool. If the number is 4.0, you do not have to make any
changes. If it is not, double-click the version number. The Edit Application Pool
dialog box opens.

4. Under .NET Framework version, select v4.0.
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5. Click OK.

Configure the Interaction Receiver Application Pool with a SMUSER Account

1. In the Start menu, select Administrative Tools > Internet Information Server (IIS)
Manager.

The Internet Information Server (IIS) Manager opens.

2. In the left pane, expand the server name, and select Application Pools.
3. Right click the Interaction Receiver Application Pool and select Advanced

Settings
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4. Under Process Model, change the Identity to SMUSER account.
5. Click OK.

Important
For additional details about the SMUSER account
refer to Configuring Permissions

Installing the UPlatform Server

Installing the UPlatform Server
The UPlatform Server manages all the processing tasks of SpeechMiner—fetching,
recognition, categorization, exploration, compression, and indexing. This section explains
how to install the SpeechMiner UPlatform Server. It should be installed on all machines on
which SpeechMiner processing tasks take place. You can install the UPlatform server on
one or more machines in your system, as required.
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Important
• After you have installed the UPlatform server

and created the required folders, it is
recommended to turn off error reporting on
the server. For additional information, see
http://technet.microsoft.com/en-us/library/
cc754364.aspx.

• Regional settings in the Recognition server
should be English US or the decimal point
separator must be "." and the group
separator must be ",", otherwise the
recognition will not work well.

Procedure

1. To begin the installation of the Uplatform server, run the setup wizard as described
under Installing Using the Wizard on the Uplatform server machine.

2. Follow the instructions, until the Choose Components screen opens.
3. Select the following components:

◦ Uplatform
◦ ULogger
◦ Interaction Receiver
◦ Nuance License
◦ SMConfig

4. Click Next.

Important
◦ If you included Nuance License in the

components, the Language Selection
screen opens. Skip the next step.

◦ If you did not include Nuance License,
the Nuance License screen opens.

5. In the Nuance License screen, enter the names of one or more Nuance license
servers you want to use, as explained in the screen, and then click Next.
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6. In the Language Selection screen, select the languages you want to install.

7. Click Next. The Choose Install Location screen opens.
8. Modify the default installation location if necessary, and then click Install. The

installation process begins. When the process is completed select Restart Now, and
then click Finish. A warning message appears.

9. In the warning message, click OK. The server restarts.

Installing SMART

Installing SMART
The SpeechMiner Administration Tool (SMART) enables users to configure the Speech
Analytics system to search interactions for specific topics and other characteristics. SMART
should be installed on the work station of each user.

To install SMART on a user's computer:
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1. On the Uplatform server machine, run the Setup Wizard, as described under
Installing Using the Wizard.

2. Follow the instructions until the Choose Components screen opens.
3. Select the following components:

◦ Smart
◦ ULogger
◦ Nuance Licence
◦ SMConfig

4. Click Next.
◦ If you included Nuance License in the components you selected, the

Language Selection screen opens. Skip the next step.
◦ If you did not include Nuance License, the Nuance License screen opens.

5. In the Nuance License screen, enter the names of one or more Nuance license
servers you want to us, then click Next.
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6. In the Language Selection screen, select the languages you want to install.

7. Click Next. The Choose Install Location screen opens.
8. Modify the default installation location if necessary, then click Install. The installation

process begins. When the process is completed select Restart Now, then click
Finish. A warning message appears.

9. In the warning message, click OK. The server restarts.

Required Folders

Creating the Required Folders

After you install the SpeechMiner components, manually create the shared folders as listed
in the table. These folders will be used by SpeechMiner to store the audio, index, and
backup files used by the system.
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Important
Ensure that enough storage space is available for
these purposes on the machines on which you
create the folders. By default, the minimum space
required for each folder is 15GB. The minimum value
is configurable in the minimumFolderSpaceMB field
in the monitorTbl table in the SpeechMiner database.

All SpeechMiner machines should have access to these shared folders, and they should be
shared with all groups and users that require access to them. It is recommended to create
the folders on the same LAN as the SpeechMiner system components.

The folder names listed below are recommended, for convenience, but you can actually use
any names you choose. In addition, you can create multiple folders for most of the folder
types, as explained below. For information about configuring SpeechMiner to use these
folders, see Sites & Machines.

Important
When you configure the shares, make sure to
specifically give write permissions to the user
installing SpeechMiner and to the system user
(SMUSER), both under Sharing and under Security.

Folder
Name Description Quantity

Input

Folder in which interactions
data and metadata will be
placed by Uconnector when it
retrieves them from the
recording system; fetchers
collect the data from input
folders, prepare it for
processing by SpeechMiner,
and then place it into store
folders.

One folder for each fetcher task; if there
are multiple recording systems, or
multiple storage media used for storing
the unprocessed data, a fetcher task
must be created for each data source
and for each input folder. For information
about deciding how many fetchers to
create, see Configuring Machines and
Tasks.
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Interaction
Receiver
Input

Folder in which the audio files
that are received from the
Genesys Interaction Recording
solution will be placed, and later
processed by the Interaction
Receiver.

Note: This is a different folder
than the Input folder which is
used by fetchers.

One for the entire system.

Store
Folder in which interactions will
be placed by fetchers to await
processing by SpeechMiner.

The system can have multiple store
folders—for example, if there are multiple
storage media used for storing the
processed data, you can create a folder
on each of them.

Filtered
Folder in which interactions with
non-existant or inactive
Programs will be placed.

One for each site in the system.

Grammar

The "package" folder, in which
the rules for processing voice
interactions, including those
defined in SMART, are stored.

One for the entire system.

Note: If you want to have more than one
copy of the folder, you can create
additional folders and configure
SpeechMiner to use them. If you do this,
SpeechMiner will save the same content
in each of the folders, so that you will
have backups.

Index

Folder in which the system will
store an index of calls,
metadata, and events, so that
they can be found quickly
during searches.

One for the entire system.

Backup

Folder in which SpeechMiner
will store backups of SMART
definition sets (Program, Topic,
and Category definitions).

One for the entire system.

Note: If you want to have more than one
copy of the folder, you can create
additional folders and configure
SpeechMiner to use them. If you do this,
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SpeechMiner will save the same content
in each of the folders, so that you will
have backups.

Uninstalling SpeechMiner
SpeechMiner components can be installed on one machine or numerous machines. If
SpeechMiner components are installed on more than one machine, you must perform the
following procedure on each machine.

Procedure

1. Double click uninst.exe in the C:\Program Files (x86)\Genesys\software.
The SpeechMiner component is uninstalled.

Important

Uninstall does not remove Nuance data files from
the Recognition computers. Delete the Nuance
Recognizer folder from C:\Program Files
(x86)\Nuance if you do not plan on using this
machine for recognition. Nuance data files are only
located in machines on which UPlatform and SMART
were installed

Configuring SpeechMiner
This topic explains how to configure SpeechMiner after it is installed. SMConfig is used to
perform the majority of the SpeechMiner configuration. For information about installing
SMConfig, see Installing the Components.
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SMConfig is a Windows application that can be installed on any machine on your network.
Once installed it can be used to configure the entire SpeechMiner system.

The following sections describe the steps that you must perform before you can begin
working with SMConfig:

Permissions

Required Permissions
The user account from which SMConfig is opened must have read, write, and modify
permissions on the local installation folder and files.

For most of the configuration changes you can perform using SMConfig, you will need
Administrator privileges on the current machine or on other machines. For each
configuration task described below, the required permissions are listed. If you are running
SMConfig as a non-administrator user, and errors are generated during the configuration
process, make sure that you have the right permissions for the task.

In Windows Vista and later versions of Windows, if User Access Control is enabled,
SMConfig will automatically require you to run it with administrator privileges. If User
Access Control is disabled, it is recommended to manually run SMConfig with administrator
privileges. To do this, right-click the SMConfig icon, and then select Run as administrator.

For more information on the permissions required for the other SpeechMiner components,
see Configuring Permissions.

Database Connection

Encrypting the Connection to the Database
The connection between SMConfig and the database can be encrypted to ensure that
confidential data cannot be intercepted and viewed by unauthorized people. This option is
configured by the system administrator on the SQL database server. Three encryption
settings are defined there:

• Always use encryption
• Never use encryption
• Use encryption when the user requests it

If the latter setting is implemented in your system, you can choose to use an encrypted
connection when you log into SMConfig. If the database server is configured to always
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encrypt or not to encrypt at all, you cannot change this option when you log into SMConfig,
and selecting one of the options has no affect.

Starting SMConfig

Starting SMConfig
SMConfig can be run on any machine in your system in which it is installed. During
installation, an SMConfig icon is placed on the desktop of the machine.

You can log into SMConfig in one of the following ways:

• Using a SpeechMiner user account
• Using the Windows account you used to log onto the PC
• Using a Genesys user account and connecting to a Genesys configuration server for

confirmation

Important
Genesys Authentication is only implemented if
SpeechMiner is deployed with GIR.

To open SMConfig:

1. On the desktop of the computer, double-click the icon. The SMConfig -
Login dialog box appears.
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2. Select the type of user account you want to use to log into SpeechMiner:
◦ SpeechMiner Authentication: Use a username and password that are

managed by SpeechMiner.
◦ Windows Authentication: Use the username and password you used to log

into Windows.
◦ Genesys Authentication: Use a Genesys username and password.

Important
Genesys authentication users can only be set in
Genesys Administration Extension (GAX).

3. In the Username and Password fields, type your username and password.

Important
If you are logging in using Windows
Authentication, your username and password
are inserted automatically, and the username is
in the form domain\username.
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4. If this is the first time you are opening SMConfig on this computer, or if you want to
change the existing database settings, click the DB Settings arrow. The Login
dialog box expands and displays the database settings.

Important
If you do not need to set or modify the database
settings, skip this and the next step.

5. Fill in the fields as follows:

Field Description

SQL Server
Authentication
/ Windows
Authentication

Select SQL Server Authentication if the username and password
for accessing the database are managed on the SQL server.
SelectWindows Authentication if you log into the database using
the same username and password you used to log into Windows.

Note: If you are not sure which option to choose, consult your
system administrator.
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Server

The name of the database server

Note: If the database is a named instance on the server, enter
both the server name and the instance name, in the format
server_name\instance_name.

Port

The port to use to connect to the database server

Note: This should normally be left as <default>, even if the
database is a named instance.

Username

The username to use to connect to the database

Note: This field is not available when Windows Authentication is
selected. In this case, the username is automatically taken from
the username used to log into Windows.

Password

The password to use to connect to the database

Note: This field is not available when Windows Authentication
is selected. In this case, the password is automatically taken
from the username used to log into Windows.

Database The name of the database

Encrypt
connection

If encrypting the connection to the database is optional in your
system, select this option to activate encryption.

Note: If encryption is always turned on in your system, selecting
or clearing this option will have no effect. If encryption is always
turned off in your system, selecting this option will prevent
SMConfig from connecting to the database server and you will
not be able to log in. In this case, an error message stating,
Could not connect to database. Please check
database settings, will appear when you click OK.

6. If you have chosen to log in using Genesys authentication, an additional option,
Configuration Server Settings, appears below DB Settings. If this is either the first
time you are opening SMConfig on this computer, or you want to change the existing
Genesys configuration server settings, click the Configuration Server Settings
arrow. The Login dialog box expands and displays the configuration-server settings.
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Important
If you do not need to set or modify the Genesys
authentication settings, skip this and the next
step.

7. Enter the name of the server and the port to use to verify the user information, as
follows:

◦ Server—Enter the name of the configuration server.
◦ Port—The port to use to connect to the configuration server in order to verify

the user information.

After setting or updating the configuration server host and port in SMConfig (either in
the Login window, or in the Sites and Machines panel), the IIS should be restarted.

8. Click OK. You are logged into the system, and the SpeechMiner Configuration
Tool (SMConfig) window opens with the first screen, Sites and Machines,
displayed.
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The SMConfig interface contains panels (Sites and Machines, Reports, etc.) in which
various categories of configuration settings can be accessed.

To open a panel:

• On the left side of the window, select the icon of the panel. The panel opens on the
right side of the window.

Saving Changes
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Saving the Changes in SMConfig
Changes you make in one panel of SMConfig are saved temporarily if you open a different
panel. Nonetheless, you must click Save in each panel to save the settings in that panel.

After you click Save, before the settings are actually saved, some settings go through a
validation process. Validation ensures that the locations specified for folders and files exist
and can be accessed, and checks that certain important parameters are configured properly.
Certain key settings are always validated when Save is selected; you can choose to have
the system validate certain others if you wish.

During the validation process, a Progress window is displayed. The window lists the stages
of the validation process as they are completed, with an icon indicating the status of each
stage.

Icon Description
Success: Validation of the stage was successful.
Warning: Validation of the stage was successful, but some problematic issues
were detected.
Failure: Validation of the stage failed, because of the problems indicated. No
changes to the configuration were saved.

When the process is complete, the Close button at the bottom of the window becomes
active. If validation was successful, the last line of the log says Done. If the Progress
window contains any stages that failed (indicated by ), the entire save process is
cancelled. The following screenshots depict examples of each status:
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To see details about a warning or failure:

• In the Progress window, select the item. Details are displayed at the bottom of the
window.
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After the configuration changes are successfully saved, a Restart Services message
appears.
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Select Yes to restart all of the services, or No if you prefer to restart them later (either after
you make additional configuration changes, or manually from the Services panel.)

Using SMConfig
This section describes how to use SMConfig to configure the Enterprise.

Using the SMConfig to Configure SpeechMiner
The section describes the sections of SMConfig.

Sites & Machines

Sites & Machines

The first panel of the SMConfig application, Sites & Machines, is used to configure the
layout of the system as well as some other system-wide parameters.

This tool enables you to configure sites, machines and tasks, and system index searches.
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Configuring Sites
A site is a single geographical location in which SpeechMiner servers are installed. One
SpeechMiner system, which has one database, can have a number of sites. All the sites
configured in the Site section of the Sites & Machines panel are locations that connect to
the SpeechMiner database. If your SpeechMiner is set up in more than one location,
configuring each location as a site helps to minimize the bandwidth needed for call
processing.

Every SpeechMiner system has at least one site. The first site is created automatically, and
is initially called "default." Immediately after SpeechMiner is installed, the "default" site is
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automatically configured to include all the servers in the local network. You can change the
name of the default site, and add sites, as required. If you create new sites, you can move
servers that are listed under the default site to other sites.

Permissions

Required Permissions

Validation of the input, filtered, store, and installation folders can only be
performed if the user account used to log into SMConfig has administrator permissions on
the machine that is being configured. This is because SMConfig must use the $ share to
check that the installation folder exists.

Default Site

Configuring the Default Site

Some of the settings in the Sites & Machines panel are configured per site, and others are
configured for the entire system. This section explains how to configure the default site by
configuring the site and system settings defined in the Sites & Machines panel.

After you configure the settings, and click Save to save them, SMConfig automatically
validates the key folders you specified by checking that they exist and are configured with
the required permissions. Validation is always performed on the items listed under Machines
and Tasks. Validation of other settings is optional, as indicated below. For additional
information, see Saving Changes.

To configure the default site:

1. In the Sites & Machines panel, fill in the fields as follows:

Field Description

Site Name The name of the site. Initially, the site is called "default." Modify
this field to change the name.

Filtered Dir
Enter the location of the folder called filtered that you created (see
Creating the Required Folders). For example, the required path
format is \\computer\data\input.
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Input Folders

Click to add a line to the list. Then, modify the line to give the
location of the input folder you created (see Creating the Required
Folders).

If you will be using multiple input folders for this site, repeat this
procedure to add additional lines to the list, as necessary. For
example, the required path format is \\computer\data\input.

Store
Folders

Click to add a line to the list. Then, modify the line to give the
location of the store folder you created (see Creating the Required
Folders).

If you will be using multiple store folders for this site, repeat this
procedure to add additional lines to the list, as necessary.

Validate
input,
filtered,
store, and
installation
folders

Select this option if you want SMConfig to validate the input,
filtered, store, and installation folders after you click
Save (see Saving Changes).

Cross site
processing
allowed

If your system will have more than one site, select this option to
enable processing of interactions from other sites at this site.
When this option is selected, the Recognizers at this site will give
priority to processing local files, but no local files need to be
processed, they will process calls from remote locations.
Selecting this option can improve the overall performance of the
system, but it does mean that audio files will be transmitted over
the network.

Prefer
compressed
remote audio

If cross-site processing is activated, select this option to give
priority to compressed audio files if they are available. If this
option is selected, when call data is transmitted from a remote site
to this site for processing, the system will send the compressed
versions of calls if they are available. In this case, the compressed
audio will be decompressed before being processed by the
Recognizer. Even so, the quality of the audio input may be
diminished slightly, and this may impact the recognition quality.
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Note: This option is only available when Cross site processing
allowed is selected.

Machines
and Tasks

List all the SpeechMiner machines at the site, and configure the
tasks that will run on each machine, as explained under
Configuring Machines and Tasks.

Package
Folders

Click to add a line to the list. Then, modify the line to give the
location of the grammars folder you created (see Creating the
Required Folders).

If you will be using multiple grammars folders in your system,
repeat this procedure to add additional lines to the list, as
necessary. For example, the required path format is
\\computer\data\input.

Backup
Folders

Click to add a line to the list. Then, modify the line to give the
location of the backup folder you created (see Creating the
Required Folders).

If you will be using multiple backup folders in your system, repeat
this procedure to add additional lines to the list, as necessary. For
example, the required path format is \\computer\data\
input.

Validate
Report
Server

Select this option if you are configuring SpeechMiner to use a
report server. SMConfig will check that the parameters are
correct.

Note: If you select this option, SMConfig will try to validate that
the user who is running SMConfig has access to the report web
service and can call methods using this web service. Therefore,
the user account that was used to run SMConfig must have the
Content Manager role on the report server (see Configuring
Permissions for UPlatform). Folders Select this option if you want
SMConfig to check whether the Package, Backup, and Index
folders exist and are configured properly.

Report
Server Fill in the fields in this area as follows:
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◦ Server Name: The name of the machine on which the
report server is installed

◦ Protocol: The protocol SpeechMiner must use to connect
to the report server

◦ Port: The port SpeechMiner must use to connect to the
report server

◦ Virtual Directory: The folder of the reports on the report
server—usually named ReportServer. If the database is
a named instance, enter both the folder name and the
instance name, in the format
ReportServer_<instance_name>.

Note: If you plan to use the report server, select Validate Report
Server.

Email

Fill in the fields in this area as follows:
◦ Email Server: The name of the email server SpeechMiner

must use to send alerts, notifications, and reports
◦ Alerts Email: The email address SpeechMiner must use

as the sender address when it sends email notifications

Index Folder

Click to add a line to the list. Then, modify the line to give the
location of the index folder you created (see Creating the
Required Folders).

For example, the required path format is \\computer\data\
index.

Default
Language

Select the default language for new Programs that are opened in
SMART. (If additional languages are installed in SpeechMiner, the
languages of individual Programs can be changed in SMART
when the Programs are created.)

Note: Only the languages selected under Select Languages
appear in the dropdown list.

Select
Languages

Select all of the languages for which you will want to perform
speech recognition. These languages will appear as language
options in SpeechMiner and in SMART.
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Note: In order to create and apply Programs in these languages,
their language packs must also be installed. The language packs
are installed as part of the SpeechMiner installation process (see
Running the Setup Program and Installing SMART). Note:The
langauge selections here do not affect the language of the web-
based interface. The interface language is selected in the settings
of the Web server, under Machines & Tasks.

Configuration
Server

If users will use Genesys credentials to log into any of the

SpeechMiner components from this site, Click to add a line
to the list and modify it so that it points to the location of the
Genesys Configuration server (that is, <config_server>:<port>).

◦ Server Name: The name of the machine on which the
Genesys configuration server is installed

◦ Port: The port SpeechMiner should use to connect to the
configuration server

To configure backup configuration servers, add additional
lines with their details. After setting or updating the
configuration server host and port in SMConfig (either in
the Login window, or in the Sites and Machines panel), the
IIS should be restarted.

2. Click Save. The system validates the settings, and then, if the validation is
successful, implements them. The Progress window opens and shows information
about the implementation process.

Add a Site

Adding a Site

If your system will have servers at more than one site, you can add additional sites to the
configuration in SMConfig. A new tab is added to the Sites & Machines panel for each site
you create. The settings in the upper half of the panel, under Sites and Machines and
Tasks are configured for each site. The settings in the lower half of the panel are configured
for each system, and thus are not changed when you add an additional site.
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Before you begin adding the site, create filtered, input, and store folders on a
machine at the new site (see Creating the Required Folders).

To add a site:

1. In the upper-left of the Sites & Machines panel, select . A new tab is added to
the site-setting area in the upper part of the panel.

2. Under Site Name, modify the name as required. The name of the tab is
automatically updated.

3. Under Sites and Machines and Tasks, fill in the fields for the new site.

Configuring Machines and Tasks
The Sites & Machines panel must list all the machines used by SpeechMiner at each site,
and the tasks they will run. Before you begin configuring the settings in this panel, map out
the machines in your system, their specifications, the sites at which they are located, and the
tasks that must be performed at each site. Using this information, you can decide which
tasks to run on each machine.
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Important
In SMConfig, in the Sites and Machines panel, when
the system tasks are saved, warning messages
indicate that the system does not include
Categorizer, Active Search and Exploration tasks.
These messages can be ignored when working in
Recording UI Mode, since these tasks are not
available in this mode.

Choose the Task

Choosing Which Tasks to Run on Each Machine

Before you can configure the machines and their tasks, you must decide which tasks to
assign to each machine. Each machine can have a number of different roles at one site. The
entire system must include machines that fill all of the following roles:

• Web server: Runs the SpeechMiner web-based interface.
• Interaction Receiver: Used for the Recording UI and Recording+Analytics modes. It

receives interaction data and metadata from the Genesys Interaction Recording
system, inserts it into the SpeechMiner database, and places the data files in the
Store folder to await processing.

• Fetcher: Takes unprocessed interaction data and metadata from the input folder
(where the UConnector placed it after retrieving it from the recording system), inserts
it into the SpeechMiner database, prepares the data files for processing by
SpeechMiner, and places it in the store folder to await processin.

• Call Recognizer: Processes call audio according to the requirements of the program
to which the call belongs by transcribing the text and identifying topics and other
events in it.

• Indexer: Maintains an index of calls, metadata, and events, so it can be searched
quickly.

• Report caching: Runs reports that are included in active users' Views pages
overnight so that they can be displayed quickly in their widgets when the users open
their Views pages; the amount of time to store cached results is configured in the
Reports panel.

• Active Search Manager: Enables the Active Search feature to work in the web-
based interface.
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• Exploration: Performs the data analysis required for the Exploration feature of the
web-based interface.

• Recategorizer: Assigns Categories to the processed interactions in accordance with
the Category definitions defined in the system.

• Text Recognizer: Processes written interaction input data and identifies Topics and
other events in it.

Important
The Exploration and Active Search tasks use the
Index folder. Machines that perform these tasks must
be physically connected to the same LAN as the
Index folder and the Index task).

Normally, each site will have:

• One Web server
• One or more fetchers
• Several Recognizers, Recategorizers, Active Search Managers, and Monitors
• One or more Indexer tasks (The Indexer tasks should only be configured on

machines that are located on the same local network as the index folder.)

Important
Monitors run on all computers in the system.
Because of this, there is no option to assign the
Monitor task to specific machines, and it does not
appear in the list of roles above.

It is recommended to run the Recategorizers and the
Active Search Managers on the same machines as
the Recognizers.

Optimizing the Number of Fetchers

To optimize the rate at which interaction data is fetched, multiple fetchers can run
simultaneously. You can configure SpeechMiner to employ multiple fetchers on one or more
machines. However, if too many fetchers run on a single machine simultaneously, the CPU
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may not be able to run all of its tasks efficiently. The optimal number of fetchers to run on a
single machine is a function of how powerful the CPU of the machine is. A general starting
point on a new SpeechMiner installation is to assign 0.5 fetcher tasks per core on each
fetcher machine. Normally, two fetchers will maximize the CPU usage on a quad-core
machine.

Optimizing the Number of Call Recognizers

To maximize the speed of interaction processing, multiple Call Recognizers can run
simultaneously. You can configure SpeechMiner to employ multiple Call Recognizers on one
or more machines. However, if too many Call Recognizers run on a single machine
simultaneously, the CPU may not be able to run all of its tasks efficiently. The optimal
number of Call Recognizers to run on a single machine is a function of how powerful the
CPU of the machine is and how many Topics must be recognized concurrently. A general
starting point on a new SpeechMiner installation is to assign 1.5 Recognizer tasks per core
on each Recognition machine. Normally, six Call Recognizers will maximize the CPU usage
on a quad-core machine.

Important
The total number of recognition tasks cannot exceed
the number in the SpeechMiner license under
<maxCallProcessing>xx</maxCallProcessing>.

The Call Recognizers in your system are run by a special Recognition process
(uRecognizer.exe) that is distinct from the Platform process (uPlatform.exe). Each
Recognition process can manage multiple Call Recognizers. You can configure the
maximum number of Call Recognizers that should be managed by each Recognition
process. If the number is too low, performance may be impacted; if it is too high, the process
may run out of memory. Running more than six Call Recognizers per process is not
recommended. Unless you are running the processes on a virtual machine(VM), it is
recommended to configure the system to run at most six Call Recognizers per process.
Then, if you encounter memory problems, reduce this number as necessary to eliminate the
problems. On a virtual machine, it is highly recommended to run only two Call Recognizers
per process. If you run more than two Call Recognizers simultaneously on a VM, they slow
one another down considerably. This recommendation is relevant for virtual machines
running either on VMware or Hyper-V servers.

Configure the Machine
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Configuring the Properties of a Machine

You configure the properties of a machine by selecting the tasks it should perform.

To configure the properties of a machine:

1. Under Machines & Tasks, double-click the machine. A Properties window opens
and displays the properties of the machine.

2. Select all of the tasks the machine should perform.
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3. If you selected Web Server, select the protocol, specify the port and virtual folder,
and select the langauge of the web-based interface.
In addition, if the index folder used by the system is on a different network, it is
recommended that you configure your web server to work with the remote web
service. For additional information about this option, see Remote Index Search.

4. If you selected Interaction Receiver, click the Parameters button to its right. In the
dialog box, enter the location of the Interaction Receiver Input folder in
which the audio files received from the Genesys Interaction Recording solution will
be placed , and then click OK. Note that the Interaction Receiver Input
folder is not the same folder as the Input folder used by the fetchers.

5. If you selected Fetcher, configure the Fetcher settings as explained below.
6. If you selected Call Recognizer, configure the Call Recognizer settings as

explained below.
7. Click OK. The machine is added to the list of machines at the site.

Configuring the Settings of the Fetchers

To configure the settings of the fetchers:

1. To the right of the Fetcher checkbox, select the number of fetchers that should run
on the machine.

2. Click the Parameters button. The Fetcher Parameters window opens and displays
a list of all the input folders that are configured for the site.
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3. Under Number of Fetchers, specify how many fetchers should retrieve interaction
data from each input folder. Modify the values so that the sum of all the fetchers
defined matches the number of fetchers that you specified should run on the
machine.

4. Click OK.

Configuring the Settings of the Call Recognizers

To configure the settings of the Call Recognizers:

1. To the right of the Fetcher checkbox, select the number of Call Recognizers that
should run on the machine.

2. Click the Parameters button. The Recognizer Parameters window opens and
displays a list of all the input folders that are configured for the site.

3. Fill in the fields as follows:

Field Description
Maximum
number of
recognizers
per
process

How many Call Recognizers can be handled by each process.

Server port
range start

The ports that will be used by the Call Recognizers; the system will
use multiple ports, as necessary, beginning with the port entered in
this field. By default, this is port 2001. You can change this number
if it conflicts with other port settings in your system.

Limit
number of
Active

Active Search is a feature that users can access from the
SpeechMiner web-based interface. It allows users to reprocess
calls in order to search for new terms that were not sought in the
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Search
recognizers

original processing. Active Search uses the same Call Recognizers
that are used for the original processing of calls. If Active Search is
running at the same time as routine call processing, it may slow the
routine processing down considerably by using its Call
Recognizers.

If Active Search is frequently run during the time when routine call
processing is performed, you may wish to limit the number of Call
Recognizers that can be used by Active Search at any given time.
To do so, enter the maximum number of Call Recognizers that
Active Search can use at one time.

4. Click OK.

Adding Machines to a Site

You can add machines to sites as required.

To add a machine to a site:

1. Under Machines & Tasks, click . A blank Properties window opens.
2. Fill in the name and properties of the machine.
3. Click OK. The machine is added to the list of machines at the site.

Configuring Remote Index Search
The index is a collection of system files. When SpeechMiner searches for calls in the index,
it reads the index files from the hard drive on which they are stored. These index files can be
on the hard drive of the machine performing the search (the Web server), on a different
machine on the same LAN, or on a different machine on a remote LAN.

Whenever the index folder is on a different machine from the Web server performing the
search, Windows sharing is used to enable the Web server to access the index files. If both
machines are on the same LAN, this arrangement should not cause any performance
issues. But when the Web machine and the index machine are on different sites that
connect to one another over the internet, accessing the system files on the index machine
directly, via Windows sharing, can be slow, especially if the index files are large.
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To solve this issue, each Web machine can be configured to either search the index files
directly or to use Web service calls.

Consider, for example, a SpeechMiner system that has two sites: Both sites have Web
servers, and the second site also stores the index files. In this system, we configure the Web
server at Site 2 to search the index files directly, because the index files are located on the
same machine as the Web server. On the other hand, we configure the Web server at Site 1
to search the index using Web service calls to the Web server at Site 2. This arrangement is
illustrated in the following diagram:

This configuration is set up in the Properties windows of each of the machines in the
system.

Deploying SpeechMiner Configuring SpeechMiner

Admin Guide 115



To configure a Web server to search the system files directly:

• In the Properties window of the Web server, clear the Search using remote web
service checkbox.

To configure a Web server to search the system files by calling the Web service on another
machine:

• In the Properties window of the Web server, select the Search using remote web
service checkbox. The Computer field becomes active.
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• In the Computer field, select the Web server to which search requests should be
sent.

Licenses

Licenses

For the system to process calls, enter the licenses you received from Genesys must be
entered in the Licenses panel. The licenses are not included in the SpeechMiner installation
folder.
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To update the licenses:

1. Copy the text of the SpeechMiner license that was supplied.
2. In SMConfig, in the Licenses panel, paste the license text into the SpeechMiner

License field.
3. Copy the text of the Nuance license that was supplied.
4. In SMConfig, in the Licenses panel, paste the license text into the Nuance License

field.
5. Click Save.

Important
If the license texts are stored in separate files, as an
alternative to the procedure described above, you
can browse to locate the files. When you open the
relevant file, its contents are automatically copied
into the appropriate field.

Services

Services

The Services panel is used to manage the SpeechMiner services. You can use it to:

• Register all the SpeechMiner services on each machine in the system
• Update the SpeechMiner configuration files on each machine
• Start, restart, and stop services

You must perform these actions at the end of the installation process, and also whenever
you add, change, or remove services or machines to or from the system. You can also use
the Services panel to restart or stop services whenever necessary.
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Initial Configuration
After you install SpeechMiner and configure its components in SMConfig, you must register
all of the SpeechMiner services, update the SpeechMiner configuration files on each
machine, and start all Uplatform servers. In addition, whenever you make changes to the
system, you should follow the same procedures, as explained below. To configure the
services in your system:

1. In the Services panel, fill in the fields as follows:

Field Description

Deploying SpeechMiner Configuring SpeechMiner

Admin Guide 119



Create
performance
counters

Select this option to configure the performance counters on each
of the selected machines.

Note: Performance counters should normally be configured only
once for each machine. Select this option for all machines when
you first install SpeechMiner. Then, if you add new machines to
the system, select this option for the new machines.

Register
services

Select this option to register the relevant services on each of the
selected machines.

When you select this option, the Credentials area becomes
active. Enter the credentials of the Windows user that will run the
services (typically, SMUSER).
Notes:
Service registration should be performed once for each machine
when SpeechMiner is first installed. It should be performed again if
the credentials of the Windows user account running the services
are changed. Select this option for all machines when you first
install SpeechMiner. Then, if you add new machines to the system,
select this option for the new machines. If the credentials given are
for a local user on each machine rather than a domain user, under
Domain, enter a "." (dot). The Uplatform service will be registered
but the user will not have the "Run as Service" role. You will have
to manually go to the Windows services management tool on each
machine, enter the password, and click Apply.

Update
config files

Select this option to update the SpeechMiner configuration files on
each of the selected machines.

When you select this option, the Credentials area becomes
active. Enter the Windows user that will run the services(typically,
SMUSER). In addition, the encryption options become active. Select
the required options.
Note: Updating of configuration files should be performed once for
each machine when SpeechMiner is first installed. It should be
performed again if the credentials of the Windows user account
running the services are changed. Select this option for all
machines when you first install SpeechMiner. Then, if you add new
machines to the system, select this option for the new machines.
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Restart
Services /
Stop
Services

All the Uplatform services must be restarted after the installation
and configuration processes are completed. To do this, under
Restart Services and, select change status to run. Then, under
Machine, make sure all servers on which Uplatform is installed are
selected.

Note: The restart and stop options in this panel should also be
used whenever you need to restart or stop any of the SpeechMiner
servers (see Starting and Stopping the System).

Update
Nuance
license
server

If your Nuance license servers are installed on central machines,
enter the list of servers and ports in this box. This will update the
selected machines' environment variables so that they point to
these license servers. Separate entries with semi-colons (;).

If you want SMART to access a central license server, add this
environment variable to the machine on which SMART is installed:
SWILicenseServerList-port@server

Notes:

◦ Select this option for all machines when you first install
SpeechMiner. If you relocate the license server to a
different machine, add additional servers, or remove
existing ones, run this option and select all the machines in
your system.

◦ If you are updating the Nuance license servers on remote
machines, the Remote Registry service must be running on
those machines. If it is not running on one of the machines,
the error "Failed to update Nuance license on [MACHINE
NAME]. The network path was not found." will appear in
the Progress window.

◦ If you want a machine to work with a local license server,
clear the text box, verify that the check box is selected and
save.

Select/
Deselect all

Select the checkbox to select all of the machines in the list below
for updating. Clear it to clear all of the selections in the list.

Machine Select the machines for which you want to implement the options
you selected on the left side of the panel.
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2. Click Save. The system begins to implement the settings you selected, and the
Progress window opens and shows information about the implementation process.

Required Permissions
The user account used to log into SMConfig must have the required permissions in order for
SMConfig to perform the actions selected in the Services panel. Some of the requirements
are for permissions on the local machine (the machine on which SMConfig is currently
running); others are for permissions on the selected remote machines. The various options
in the panel have different permission requirements, as explained in the following table:

Option Required
Permissions Additional Details

Create
Performance
Counters

• For remote
machines:
Administrator
privileges on
the selected
machines

• For the local
machine:
Under
Windows
Server 2008,
Power User
privileges

Register
Services

Administrator
privileges on the
selected machines.

Administrator privileges on the selected machines
are required in order to register the Uplatform
service. These privileges are required for running
remote commands on the selected machines and
for registering the services using the Windows
Services API.

Update
Config Files

Administrator
privileges on the
local machine and
on all selected
machines.

Administrator privileges on the selected machines
are required in order to update the configuration
files on the local machine and on the remote
machines. These privileges are required for
accessing the files using the $ share and for
encryption and decryption (if Encrypt config files is
selected).
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Restart/Stop
Services

• For remote
machines:
Administrator
privileges on
the selected
machines

• For the local
machine:
Power User
privileges

• To change the Uplatform service status on
remote machines, Administrator
permissions are required in order to get the
service information and change it's status
remotely using the Windows Services API.

• To change the Uplatform service status on
the local machine Power User privileges on
the local machine are sufficient.

Update
Nuance
license
server

• For remote
machines:
Administrator
privileges on
the selected
machines.

• For the local
machine:
Under
Windows
Server 2008,
Power User
privileges.

Administrator permissions are required in order to
update the registry key that controls the Nuance
environment variables.

Starting and Stopping the System
You can start, restart, or stop SpeechMiner services in SMConfig in the Services panel.
One case in which you must use this feature to start the Uplatform services is after the initial
installation and configuration of the system (see Initial Configuration). You can also use
these features to change the status of a service from run to idle, or vice versa, or to
completely stop a service.

Important
You can also toggle between "idle" status and "run"
in the SpeechMiner web interface, in the System
Monitor page.

To start, restart, or stop SpeechMiner services:
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1. In the Services panel, clear the Create Performance Counters, Register
Services, and Update Config Files checkboxes.

2. Select one of the following options:
◦ Restart Services and leave status as is: Restarts the selected services,

and leaves them in the mode they were in previously
◦ Restart Services and change status to run: Restarts the selected services,

and puts them into "run" mode
◦ Restart Services and change status to idle: Restarts the selected services,

and puts them into "idle" mode
◦ Stop Services: Stops the selected services

3. In the list of machines, select the servers you want to restart or stop.
4. Click Save. The system begins to implement the options you selected, and the

Progress window opens and shows information about the implementation process.

Audio

Audio

The Audio panel of SMConfig is used to configure the call-audio recognition and playback
formats, retention periods for each format and site, and playback rates. Below is a summary
of the audio formats that are supported for each audio function.
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Configuring the Audio Settings

The Audio panel contains the basic audio setting options for the system.

Important
This panel includes the most common audio
configurations. If you require a more complex
configuration, you must manually define it in the
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database. Bear in mind that, if you do so, the
configuration you defined in the database will not
appear in the Audio panel. In this case, be careful
not to click Save in this panel. If you do, the settings
in the panel will overwrite the more complex
configuration you defined in the database.

To configure call-audio settings:

1. In the Audio panel, fill in the fields as follows:

Field Description

Select the
audio
format for
recognition

Select the format of the call audio that must be used by
SpeechMiner during the recognition process. If the audio received
from the recording system is not in the format selected here, the
fetchers will automatically convert it to this format (after they
retrieve it from the input folders) before they save it in the store
folders to await processing by SpeechMiner. If the system is used
in the Recording UI mode or Recording and Analytics mode, the
format must be set to WAV_PCM.

Create
compressed
audio file

Select the format of the call audio that must be used by
SpeechMiner for playback in the web-based interface. After the
audio of a call is processed, an additional compressed copy is
made in this format and saved in a file in the store folders.

If the system is used in the Recording UI mode, or Recording and
Analytics mode, this must be set to Do Not Generate.

If compress
format not
available

Select one of the SpeechMiner actions to be performed if a user
initiates playback of a call for which no compressed audio file is
available. (If compressed audio is available, it is automatically used
for playback.):

◦ Play recognition file: The player plays the recognition
audio file directly without any format conversion.

◦ Convert the recognition file on-the-fly to: The player first
converts the recognition audio file to the format selected
here, and then play it for the user.
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For Internet Explorer users, select the Convert the recognition
file on-the-fly to MP3 option.

Retention
Policies

Specify the retention policy, per site, for each of the audio formats
selected above. Call data is deleted from the store folder
automatically when it has been in the folder as long as the
specified retention period. The values chosen should be based
mainly on the disk space available for storing the call audio. Bear in
mind that 1 MB of disk space can contain roughly one minute of
uncompressed audio data or 15 minutes of compressed audio
data.

Default values are automatically entered for each site in the
system, with separate retention periods for each of the formats
selected under Recognition Audio Format and Playback Audio
Format, in hours. You can manually adjust the retention period for
each item, as required. To do so, double-click the item, or select it

and then select . The Retention Period dialog box opens.
Modify the value in the text field, and then click OK.

If the system is used in the Recording UI mode or Recording and
Analytics mode, set the retention policy of WAV_PCM to 0.

Notes:

◦ Selecting these options prevents the creation of
unnecessary audio files and the storage of files for longer
than is necessary.

◦ The recognition audio files of calls that have not been
processed yet, and of calls that are included in Static Call
Lists, are not deleted even when the retention period is
over.

◦ If you do not want audio data to be deleted from the store
folder automatically, enter the value -1. This value should
only be used in static systems where the number of calls is
limited and does not grow continuously.

Playback
Speeds

Enter the playback speed options that must be available to users
when they playback calls in the media player. For example, 1
means playback at the original speed, 2 means double-speed, and
so on.
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By default, only 1 is available. To add an additional speed, click

. A new line is added to the list. Modify the value in the line as
required, and then press Enter.

Encrypt
audio files

Select this option if you want the audio files to be encrypted before
they are saved in the store folder.

When you select this option, the New Password field becomes
active. Enter the encryption password in the field.

2. Click Save. The system implements the settings, and the Progress window opens
and shows information about the process.

Summary

The Audio panel summary lists the preferred formats that SpeechMiner supports:

Item Function Description

Input folder
expects Fetcher

Audio formats supported by fetchers; call audio that is
retrieved from the external recording system by UConnector
must be saved in the input folder in one of these formats.

Recognition
priorities Recognition

Preferred audio formats for the recognition process, in order
of preference; call audio that is processed by the
Recognizers should ideally be in one of these formats.

Playback
priorities Playback

Preferred audio formats for the SpeechMiner media player, in
order of preference; call audio that is played back should
ideally be in one of these formats.

Index

Index

The Index panel enables you to manage index-related tasks: backup, restore, and index
optimization.
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Backup the Index

Backing up the Index

You can back up the index automatically on a daily basis or manually as required. Note that
no incremental backup is available; every time the backup is started, all of the index files are
copied to the backup folder.
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Daily Backup

You can set a time and specify a backup folder, and SpeechMiner will automatically back up
the index every day at the specified time to the specified folder.

To set up a daily backup of the index:

1. In the Index panel, in the Daily Index Backup region, fill in the fields as follows:

Field Description
Backup
every
day at

Select the checkbox to activate the automatic daily backup, and then,
in the time field, select the time at which you want to the backup to
begin.

Keep
only
last...

Select the number of backups to keep. Older backups will be deleted
automatically.

Daily
backup
folder

Select the folder in which to store the backup data.

2. Select Save. The changes are saved, and a Progress window shows information
about the saving process.

Manual Backup

You can select a folder and back up the index to that folder manually as necessary.
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To run a backup of the index manually:

1. In the Index panel, in the Manual Index Backup region, fill in the fields as follows:

Field Description
Backup to
folder Select the folder in which to store the backup data.

Use
different
credentials

If different credentials are required to access the index folder, select
the Use Different Credentials check box, and then enter the
required user credentials.

2. Select Backup Now. The backup is performed, and a Progress window shows
information about the backup process.

Restore the Index

Restoring the Index

Restoring the index can be done in two different ways:

• Restoring the index from a backup, using SMConfig
• Creating_a_New_Index_from_Scratch|Deleting the existing index and creating a new

one from scratch

Restoring the Index from a Backup

If you have a backup of the index, it is generally preferable to restore the index from it.
Restoring the index from a backup is generally a much quicker process than creating it from

Deploying SpeechMiner Configuring SpeechMiner

Admin Guide 131



scratch, especially if the database is large. The index task re-indexes the database at a pace
of about 3,500 calls per minute. If you restore the index from a backup, only those calls that
were indexed after the backup was created must be re-indexed. Calls that are included in
the backup do not have to be re-indexed. As a result, you can start using the index almost
immediately.

Two alternative methods for restoring the index from a backup are available:

• Use the backup folder as the current index folder.
• Restore the index from the backup folder to a new index folder.

In either case, you should not restore the index folder manually. Instead, use SMConfig to
perform the restoration. Using SMConfig ensures that the process is performed properly,
and, in addition, SMConfig also takes care of re-indexing all the calls that were indexed after
the backup was created.

To restore the index from a backup:

1. In SMConfig, in the Index panel, select Restore Index Folder. The Restore Index
Folder dialog box opens.
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2. Fill in the fields as follows:

Field Description

To index
folder

Select (Minimum WEB down time) Make the latest valid backup
folder the new index folder to use the backup folder as the new
index folder, or (Recommended for the long run) Restore the
backup to a new index folder location to create a new folder to
use as the index folder.

If you chose the second option, under New index folder path,
select the folder to use as the new index folder. Note that this folder
must be empty when you begin the restoration process.

From
backup
folder

Select Restore the latest valid daily backup to restore the index
from the folder that contains the automatically generated backups of
the index (specified in the Index panel under Daily Backup
Folder), or Restore from a manual backup folder to use a
manually generated backup.
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If you chose the second option, under Manual Backup Folder,
select the folder from which to take the backup.

Use
Different
Credentials

If different credentials are required to access the index folder, select
the Use Different Credentials checkbox, and then enter the
required user credentials .

3. Click OK. The index is restored to the new index folder, and a Progress window
shows information about the restoration process.
During the process, SMConfig will also do the following:

◦ Checks the validity of the new index folder, and, if it is not valid, abort the
process.

◦ Inserts indexing requests into the index queue for all the calls that were
processed or updated after the backup was created.

◦ Notifies the Web servers that the index folder was changed.
4. When the restoration process is finished, restart the platform servers.

Creating a New Index from Scratch

If you do not have a backup of the index, you can restore it by deleting the existing index
and creating a new one. In addition, if the database is quite small, you may prefer to restore
the index in this way even if you do have a backup.

Restoring an index by creating it from scratch is generally a much slower process than
restoring it from a backup, especially if the database is large. The index task re-indexes the
database at a pace of about 3,500 calls per minute. If you re-create the index from scratch,
all of the calls in the database must be indexed.

To create a new index:

1. Stop all the Uplatform services that run index tasks.
2. Run the following SQL command: truncate table indexq
3. Delete all of the files in the index folder.
4. Run the following stored procedures in the database:

◦ To re-index the calls, run exec dbo.sp_reindexCallsByParams 3,0,
0,

◦ To re-index the text interactions, run exec
dbo.sp_reindexTextDataByParams 3,0,0,
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Important
Re-indexing the text interactions is only
relevant in SpeechMiner versions from 7.3
and on, and only if your system handles
text interactions as well as calls.

5. Restart the Uplatform services that you stopped before. After a minute or two, the
index task will start to index the calls. Newer calls will be indexed first.

Optimize the Index

Optimizing the Index

The Index Optimization task optimizes the index files of the system, thus reducing their size.
It is recommended to configure it to run at a time when the system is not in use, such as
Sunday at midnight.

To configure the system to optimize the index:

1. In SMConfig, in the Index panel, in the Weekly Index Optimization region, select
the Optimize every week at checkbox.

2. Select the day of the week on which to perform the optimization, and specify the time
to begin the process.

3. Click Save. The setting is saved, and the Progress window opens and shows
information about the saving process.

High Availability
High Availability is an automatic process for restoring an index backup. When the High
Availability feature is selected in the SMConfig Index panel, the system will detect when the
Index folder is not accessible and perform the following:

1. Switch the roles of the Index folder and the Daily Backup folder, so that the current
backup becomes the primary folder and the current index becomes a secondary
backup folder.

Indexing will take place on the new primary folder.
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2. Re-index all the interactions that were indexed after the latest daily backup was
created.

Whenever the primary folder becomes inaccessible, the folder roles will change.

The time between when the index is detected as inaccessible and when the switch
over is performed can be configured in the High Availability section of the Index
Tab. (That is, Switch after # minutes)

Reports

Reports

If you want to use any of the SpeechMiner reports, you must deploy both the MRS Library,
which is a DLL that provides support for various report features, and all the required reports,
on the report server. You can do this from the Reports panel of SMConfig. The DLL and the
reports will be deployed on the machine that is identified in the Sites & Machines panel,
specified as the Server Name parameter under the Report Server panel.
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Required Permissions

To check if the MRS Library has been deployed on the report server, and to deploy the MRS
LIbrary, SMConfig reads the report server's Registry to locate the report server’s bin folder
and then accesses the folder using the $ share. Therefore, to deploy the MRS Library and
any or all of the reports, the user account used to log into SMConfig must have administrator
permissions on the report server.
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Deploying the Reports

To deploy reports on the report server, you must first deploy the MRS Library on the server,
and then deploy the required report templates. You can perform both actions simultaneously
by selecting both options in the Reports panel. Once the MRS Library is deployed on the
server, you can deploy additional reports without redeploying the library.

Important
When you select the Reports panel, SMConfig
checks whether the MRS Library is already deployed
on the machine.

To deploy reports on the report server:

1. In the Reports panel, fill in the fields as follows:

Field Description

Set reports
caching
time

If you chose to use report caching in the Sites & Machines panel,
specify how long report results should be cached, in minutes. The
results of reports that are included in active users' Views pages will
be saved for the specified period of time. Users who open their
Views pages during that time period will see the cached results.
The recommended time period is 24 hours (i.e., 24*60=1440
minutes), because the report caching runs once every 24 hours.

Deploy
MRSLibrary

If the MRS Library has not yet been deployed on the report server,
select this option.

Note: If this option is not selected, but the checkboxes in the
Report/Resource list below are active, this means that the MRS
Library is already deployed on the machine. In this case, it is not
necessary to select this option.

Deploy
reports

Enter the location of the reports folder. This folder is called
reports, and is located in the SpeechMiner installation folder. For
example, if SpeechMiner was installed in c:\Program Files
(x86)\Genesys\Software, the path to enter would be
c:\Program Files (x86)\Genesys\Software\reports.
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Select\
Unselect
All

Select the checkbox to select all of the reports in the Report/
Resource list below for installation. Clear it to clear all of the
selections in the list.

Note: If this option is not available, this means that the MRS Library
has not yet been deployed on the machine. In this case, select
Deploy MRSLibrary, and this option will become available.

Report/
Resource

Select the reports you want to deploy on the report server

Note: If this option is not available, this means that the MRS Library
has not yet been deployed on the machine. In this case, select
Deploy MRSLibrary, and this option will become available.

2. Click Save. The system begins to deploy the reports on the report server, and the
Progress window opens and shows information about the deployment process.

Recording

Recording
When working with a Recording mode, the following configurations are required in the
Recording panel. The Recording panel only appears when you are working in a Recording +
Analytics environment or a Recording Only environment:

• Configuration

The following must be configured in the systems Configuration Server:

◦ Tenant
◦ Application Name
◦ Users Access Group

• Interaction Receiver

In systems with Call Recording mode or Call Recording and Analytics mode licenses,
the Program ID is normally assigned to calls by the recording processor.
The recording processor adds the Program ID to the call’s metadata. If the call
arrives in the SpeechMiner system without a Program ID, SpeechMiner assigns
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it the default Program ID.
By default, this value is default.

If you want to change this default value to a different value, perform the following:

◦ For Call Recording and Analytics Mode licenses, in SMART, create a
Program with the name you want to use for the default Program, and apply it.
Finally, in the SMConfig Recording panel, set Default Program to the
Program's external ID.

◦ For Call Recording Mode set Default Program to the desired value.

Set Extension Speaker Type and Trunk Speaker Type as configured in the GIR
system.

Important
For additional information see Recording
Modes.

• RP Authorization

Set the User and Password to the values configured for the RP.

• MCP Authorization

Set the User and Password to the values configured for the MCP.
The MCP authorization option is only available when working in an environment with
SpeechMiner Analytics.

• Playback
◦ Set the RCS URI value using the format: http://rcs_host:port/rcs,

or https://rcs_host:port/rcs (Web Server connection).
◦ Set the External RCS URI value (when working with encrypted Screen

Recording), using the format: http://rcs_host:port/rcs, or
https://rcs_host:port/rcs (Browser connection).
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◦ Set the HTCC URL value (when working with Screen Recording), using the
format: http://htcc_host:port, or https://htcc_host:port
(Browser connection).
If you are not working with Screen Recording, leave the HTCC URL field
empty.

Important
Use https for the RCS and HTCC connections if
the connection to the SpeechMiner web server
was configured with https.
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Additional Configurations
The following configurations are recommended for the successful completion of the
SpeechMiner configuration process:

Browser

Configuring the Browser
End users of SpeechMiner access its browser-based interface from Internet Explorer or
Google Chrome, which connects to the SpeechMiner Web server through the local network.
In order for the SpeechMiner interface to work properly, you must configure each user's
browser as explained below. The configuration changes that must be implemented are to
allow pop-ups from the SpeechMiner domain, to treat the SpeechMiner domain as part of
the local intranet (or as a trusted site), and to enable automatic updating of cached web
pages.

In addition, if Internet Explorer is running on a Windows Server 2008 machine or Windows
Server 2012 machine, the Enhanced Security Configuration feature should be turned off.
Refer to the Turning Off the Enhanced Security Configuration Feature on Windows Server
2008 / Windows Server 2012 section below.

Tip
To run SpeechMiner 8.5.3 you must use a minimum
resolution of 1366X768. We recommend that you
work with a 1680x1050 resolution.

Internet Explorer
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Configuring Internet Explorer

1. In the Internet Options dialog box, in the Security tab, select Local Intranet.

2. Add the SpeechMiner domain to the list of web sites in the Local Intranet zone.
3. Click Custom Level and select Miscellaneous > Access data sources across

domains.
4. Under Access data sources across domains, select Enable.

Selecting Enable makes Screen Recording playback possible because it allows
access from the browser to HTCC.
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5. In the Privacy tab, add the SpeechMiner domain to the list of web sites that are
permitted to open pop-ups.

6. In the General tab, under Browsing history, select Settings.
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7. Under Check for newer versions of stored pages, select Automatically.

8. Click OK to save the changes.

Important
If the SpeechMiner domain is treated as part of the
local intranet, Local intranet should appear in the
Status Bar at the bottom of the Internet Explorer
window whenever the browser is displaying a

SpeechMiner page.
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Turning Off the Enhanced Security Configuration Feature on Windows Server 2008 / Windows Server
2012

1. In the Server Manager, in the home page (the top level), expand the Security
Information section. The current settings for the Enhanced Security Configuration
feature appear under IE Enhanced Security Configuration (ESC).

2. If the current settings are not Off for Administrators and Off for Users, click
Configure IE ESC. The Internet Explorer Advanced Security Configuration
dialog box opens.
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3. For both Administrators and Users, select Off.
4. Click OK to save the changes.

Chrome

Configuring Chrome

1. In the Chrome browser, select Customize and control Google Chrome, and then
select Settings.
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2. Select Show advanced settings..., and then under Network, click Change proxy
settings... The Internet Property dialog box opens.
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3. On the Connections tab, add the SpeechMiner domain.
4. On the Privacy tab, turn off Pop-up Blocker.
5. In the General tab, under Browsing history, select Settings.
6. Under Check for newer versions of stored pages, select Automatically.
7. Click OK to save the changes.

Verify that Java Script is Enabled

To verify that Java Script is enabled:
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1. In the Chrome Broswer, navigate to Chrome Settings/Show Advanced Settings/
Privacy/Content Settings.

2. Under Java Script, select Allow all sites to run Java Script (recommended).

For more information about enabling Java Script, see http://support2.constantcontact.com/
articles/FAQ/1334?l=en_US&fs=RelatedArticle.

Date and Time
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Setting the Date and Time

The webServiceParam table has two fields for configuring the date and time display:

• globalDateFormat which configures the date format, for example: MM/dd/yy
• globalDateTimeFormat which configures the time format, for example: hh:mm tt

For additional information about the options available, see http://www.w3.org/TR/NOTE-
datetime.

When SpeechMiner's Spanish interface is used for the Web interface, the only formats
supported for globalDateTimeFormat are the following 24-hour formats: H:mm:ss or H:mm.

Forget Password Configuration

Set the Forget Password Login Option

When configuring SpeechMiner you can give users the option of recovering forgotten
passwords.
If you choose to enable users to recover their forgotten passwords, the SpeechMiner log in
screen will contain a Forget Password? link.
When the user clicks the Forget Password? link, the user will be required to enter his email
address.
The user will then receive an email with a Reset Password link.
By default the Reset Password link is only available for 4 hours. This default number can be
changed.

To enable a user to recover his password perform the following:

1. Access the webServiceParam table.
2. Change the PasswordRecovery field from false to true.

To change the Reset Password link default:

1. Access the webServiceParam table.
2. Change the resetPasswordTokenExpirationTime field from 4 hours to the

amount you prefer.
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Important
If more than one user has the same email address,
the Forget Password option will not be available.

To change the email message the user receives:

1. Access the webServiceParam table.
2. Change the resetPasswordMailBody field to the content you prefer the user to

receive.
The email message content should contain <resetLink>.
<resetLink> represents the Reset Password link.

3. Change the resetPasswordMailSubject field to the subject you prefer the user
to receive.

Resource Type

Setting the Resource Type

The resourceTypeId table contains a list of all the possible resource types.

To enable/disable a resource type in SpeechMiner, update the isEnabled field in the
resourceTypeId table with the relevant status.

VMWare

Configuring a VMWare Server

If you are installing SpeechMiner on virtual machines and using VMWare Server VSphere4,
it is recommended to use the Scheduling Affinity feature, which dedicates specific logical
CPUs for the virtual CPUs of particular VMs. Doing this can improve Recognition
performance.

To use the VMWare Scheduling Affinity feature:
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1. For each active Virtual Machine, check the VM Settings to see how many CPUs are
configured for the machine.

2. In Setting\Resources tab\Advanced CPU\Scheduling Affinity, enter the serial
numbers of the VMWare server's logical CPUs.

HTTPS for SpeechMiner

Enable HTTPS for SpeechMiner

Important
The following procedure is intended for a WIndows
2008 Server

1. Create a self signed server certificate to enable the https protocol:
a. Open the Microsoft Management Console (MMC).
b. Select File > Add / Remove Snap-in.
c. Select Certificate and click Add.
d. Click OK.
e. Select Computer account and click Next.
f. Selelct Local computer and click Finish and OK.

g. Under Certificates (Local Computer), right-click Personal, All Tasks,
Request New Certificates

The following Certificate Enrollment window appears:

h. Click Next
i. Under Active Directory Enrollment Policy, Select Computer.
j. Click Enroll and Finish.

11. Configure the Report Server:
a. Open the Reporting Services Configuration Manager.
b. Select Web Service URL.
c. Select Advanced.
d. Under Multiple SLL Identities, click Add and select the certificate you

created.
e. Click OK and select the https URL.
f. Under Multiple SSL Identities, click Add and select the certificate you

created.
g. Click OK and select the Report Manager URL.
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8. Create an SSL Binding:
a. Open IIS Manager.
b. Select Default Web Site and in the right Action pane click Bindings.
c. Click Add.
d. In the Type list select https.
e. In the IP address list select All Unassigned.
f. In the Port field enter the relevant port number.

g. In the SSL Certificate list select the relevant SSL Certificate.
8. Configure SSL settings:

a. In the IIS Manager, click Default Web Site.
b. Under IIS, select SSL Settings.
c. Select Require SSL and click Apply.

4. Restart the IIS Server.

Important
If the following error occurs after you restart the
IIS Server, it maybe due to the fact that your
Skype process is using the same ports and
should be stopped:

IIS Manager Error: The process
cannot access the file because it
is being used by another process.
(Exception from HRESULT:
0x80070020)

Additional information abouat SSL on IIS 7 can be found here: http://learn.iis.net/page.aspx/
144/how-to-set-up-ssl-on-iis-7/

Recording Modes

Additional Configuration for Recording Modes

• Create a new application for SpeechMiner with a Genesys Generic Server template
in the Genesys Administration Extension:

Deploying SpeechMiner Configuring SpeechMiner

Admin Guide 154



◦ Follow the Creating Applications Objects procedure in the Procedures tab of
the Applications page in the Genesys Administration Extension document.

◦ Verify that the name of the application that you create is the same as the
ApplicationName field in the configServer table of the SpeechMiner
database.

◦ Creating a SpeechMiner application does not require configuring connections
or options and is not integrated with LCA.

SpeechMiner Web Application

Configuring a SpeechMiner Web Application

Configure a new SpeechMiner Web application when your default web site is not sufficient
for your systems demands.

1. Open the IIS Manager.
2. Under Connections, select Sites > Default Web Sites and right-click

SpeechMiner.
3. Click Remove to remove the existing SpeechMiner Web Application.
4. Under Connections right-click the web site to which you want to add the

SpeechMiner Web Application.
5. Select Add Application.
6. In the Application Name field enter SpeechMiner for the new web application.
7. Click Select.
8. Open the Application Pool list and select SpeechMiner.
9. Click OK.

10. In the Physical Path click the Browse button and select the Installation > Web
folder. The default folder is c:\Program Files (x86)\Genesys\Software\utopy\product\
web.

11. Click OK.
The SpeechMiner Web Application appears under the web site to which you selected
to add the SpeechMiner Web Application.

Enabling CMD for SMART
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Configuring Command Line availability for SMART

To update the database configuration perform one of the procedures:

SMConfig

1. Log into SMConfig.
2. Select Services.
3. In the Services window, select Update config files.
4. Click Save.

SMART

1. Manually log into SMART.
2. Go to C:\Program Files (x86)\Genesys\Software\utopy\product\bin\release.
3. Make a copy of smart.exe.config and name the copy smartc.exe.config.
4. When asked to replace a file with the same name click Yes.

Define Caching Reports

Defining Caching Reports

All Caching tasks are listed in the Report Caching Params table.

In the default database there is one Caching task that caches all the reports in the expanded
widgets for all the active partition sets during the last 30 days.

You can select different reports to cache then those defined by default. You can also delete
the existing cache and create a new cache.

To define a new cache report:

1. Access the Report Cache Params table in the database and insert a new row.
2. Define the following parameters:

Parameter Description
Enable True
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Report
Query

The query that retrieves the report id’s and the partition strings
associated with the report you want to cache.

Within the Report Query you can use the following parameters:

Parameter Description
@templatesToExclude The templates to exclude from caching.
@usersToExclude The users to exclude from caching.

@daysUserIsActive
The users that should be cached. For example, if this is
7, then only users that are active in the last 7 days
should be cached.

numberOfProcesses The number of parallel threads that should be cached (at
the same time).

keepLogMessages The number of days log messages associated with
caching tasks be should be kept.

NotificationMail
The email address belonging to the users to whom the
caching task report should be sent when the caching is
complete.

webComputerName The name of the web server to which the reports are
cached.

RunAtTime

Defines when the caching task will run within 24hrs. The
maximum is 1440 minutes for 24hrs. For example, if you
want the cache task to run at 12 midnight and your UTC
difference is +2, enter -120. It is the difference between
UTC and the local time you want it to run in. The
difference is in minutes.

nextTimeToRun
The next time the Caching task is set to run. Set this
parameter to a low value. During the initial run the task
automatically sets the correct value.

3. Log into SMConfig.
4. Under Machines & Tasks, select one or more machines on which the Caching task

will run.

If you select more than one machine the Caching task will be divided equally
between the machines that run simultaneously. The more machines the faster the
Caching task will be completed.

5. Click Edit.
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The following Properties window appears:

6. Select Report Caching.
7. Click Ok.
8. Click Save.
9. Select the Report tab.

Deploying SpeechMiner Configuring SpeechMiner

Admin Guide 158



The following Report Deployment page is opened:

10. In the Set reports caching time (minutes) field enter 1440 (this number represents
24 hours).

11. Select all the report templates and click Save.
12. Verify that the Caching task is running:

a. Access the reportCachingLog table.
b. Select the table records and verify that the Caching task ran.
c. Access the ulogger and verify that it is caching the selected reports.

Important
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If the Report Caching task fails, the Partition Failure
error will appear in the reportCachingLog table. To
resolve this error copy the Microsoft.ReportViewer*.*
dlls from the web\bin folder to the platform bin folder
utopy\product\bin\release or Install MS Report
Viewer 2005.

Report Server Email Configuration

Report Server Email Configuration

Configure the Report Server email as follows so that the report schedule and report
deliverable functions operate as expected.

1. Access the Report Server machine.
2. Open Reporting Services Configuration Manager.
3. Click Connect to connect to the Report Server.
4. Select Service Account and define a user account with access to the SMTP server.
5. Click Apply.
6. Select E-mail Setting and define the SMTP Server and default Sender Address.
7. Click Apply.

Integrated Windows Authentication

Integrated Windows Authentication

Integrated Windows Authentication enables you to ensure that your SpeechMiner users are
not required to log into SpeechMiner every time they want to access the application.

Tip
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To configure your application to use Integrated
Windows Authentication, you must use IIS Manager
to configure your application's virtual directory
security settings and you must configure the
<authentication> element in the Web.config file.

1. Open IIS Manager and navigate to the level you want to manage. For information
about opening IIS Manager, see Open IIS Manager (IIS 7).

For information about navigating to locations in the UI, see Navigation in IIS Manager
(IIS 7).

2. In Features View, double-click Authentication.
3. On the Authentication page, select Windows Authentication.
4. In the Actions pane, click Enable to use Windows authentication and Disable to

use Anonymous authentication.
5. In your application's Web.config file or in the machine-level Web.config file, ensure

that the authentication mode is set to Windows as shown here.

...
<system.web>
...
<authentication mode="Windows"/>
...

</system.web>
...

Configuring Permissions
This section describes the permissions that must be set for the functional SpeechMiner
domain user (SMUSER) and for users of SMART.

UPlatform
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Configuring Permissions for UPlatform

SpeechMiner uses a domain user account as the credentials for all the registered
SpeechMiner services. Your IT department must be able to create this account for you. The
domain user must have assigned permissions on all machines on which the UPlatform
service will run, as described below. The user account must be created and assigned the
required permissions before you begin configuring SpeechMiner.

Important
In this guide, this functional user account is called
SMUSER.

Groups

SMUSER must be added to the following groups:

• Power Users
• Performance Monitor Users (if this group exists on the machine)

Folder Properties

In the Properties of the following folders, assign permissions to SMUSER, as follows:

Important
Tab indicates the tab in the Properties dialog box in
which the permission can be assigned.

Folder Tab Permission Comments

Genesys installation folder Security Modify
Usually C:\Program Files
(x86)\Genesys\Software

Genesys data folders Security Modify
For example, C:\data - where
the data\input and data\
filtered folders are located
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Genesys data folders Sharing Change
For example, C:\data - where
the data\input and data\
filtered folders are located

C:\Program Files
(x86)\Genesys\
Software\utopy\
product\WEB\App_Data

Security Read/Write
This is for the impersonation
user specified in the
web.config file.

Report Server

On the report server, assign the Content Manager role to SMUSER, as follows:

1. On the database server, open a browser, and navigate to //<database server
name>/reports. The SQL Server Reporting Services manager opens.

Important
If the Windows UAC (User Account Control) is
active on the server, open the browser by right-
clicking its icon and then selecting Run as
administrator.
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2. Select the Folder Settings tab.

Important
If you cannot access this folder, because you
are repeatedly asked for your credentials, and
then the screen turns blank, do the following: In
rsreportserver.config, remove the value
RSWindowsNegotiate and ensure that
RSWindowsNTLM is specified. (For more
information about this problem, and some other
solutions, see http://blogs.msdn.com/b/lukaszp/
archive/2008/03/26/solving-the-reporting-
services-login-issue-in-the-february-ctp-of-sql-
server-2008.aspx)

.
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3. If SMUSER is not on the list, click New Role Assignment and add it. If it is on the
list, click Edit to edit the existing account settings.

4. Select speechminer database > sme.
5. In the Security tab, click New Role Assignment. The New Role Assignment tab

opens.
6. In Group or user name, enter the user name (SMUSER).
7. Select the Content Manager checkbox.

8. Click OK. The Content Manager role is assigned to SMUSER.

Directories Used by ASP.NET

Give SMUSER access permissions to the IIS metabase and other directories used by
ASP.NET. To do this, an administrator can run this command:

aspnet_regiis.exe -ga "{domain}\{user}"

Uconnector
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Configuring Permissions for UConnector

A functional UConnector user should be assigned the permissions listed below. Note that
you can use SMUSER for this purpose; it is not necessary to create a dedicated domain
user for this.

• Recording-system shared folder: Read permissions
• SpeechMiner input folder: Read/write permissions

SMART

Configuring Permissions for SMART

Any user who will run SMART should have the following permissions:

Folder Permission Comments
SpeechMiner
installation folder Read/write

Usually C:\Program Files (x86)\Genesys\
Software

Package Root
Path Read/write The path configured in the Packages folders text box

in the Sites and Machines section.
Nuance
installation folder Read/write For example, C:\Program Files\Nuance

In addition, all SMART users should have permission to use .net encryption. To add this, an
administrator can run the following command:

aspnet_regiis -pa "NetFrameworkConfigurationKey" "{domain}\{user}"

Web Server

Configuring Permissions for the Web Server

Once you have installed the SpeechMiner web server, you should set the following
permissions:
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• On the folder C:\Windows\Microsoft.NET\Framework\v2.0.50727\Temporary
ASP.NET Files, give Modify permissions to the domain user that SpeechMiner will
impersonate (For the SMUSER, see Configuring Permissions for UPlatform).

• Set read/write/modify permissions to the IIS user/group (IIS_IUSRS in
Windows server 2008 and above) and the operational domain user (SMUSER) on
the SpeechMiner installation folder.

• Set read/write/modify permissions to the IIS user/group (IIS_IUSRS in
Windows server 2008 and above) on the windows temp folder.

Working with Chat Interactions
SpeechMiner supports numerous metadata for chat interactions.

This page describes the required system specifications for the successful implementation of
chat interactions.

Supported Formats

Supported Formats for SpeechMiner 8.5 and Above

• Text File
• Chat XML file (.chtx)

File Format

Chat File Format Specifications

Text File

A chat interaction in a text file format only requires a subject and the conversation. The file
does not require information about the participants.

The first line in the text file should be the subject. The second line in the text files should be
empty. The remaining lines should contain the chat conversation.

For example:
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Chat XML File (.chtx)

When using an XML file (.chtx format), the chat interactions should be configured as
follows:<textFormat>XML</textFormat>

Additional information can be added as meta data in the interaction XML file.

Important
The .chtx format and specification that is described
here is not an official format or standard. This file
format was specifically created for SpeechMiner
purposes. The assumption is that the UConnector or
any other ETL tool will create the chat conversation
in this format before sending the file to SpeechMiner.

A chat conversation in .chtx format can contain one subject, multiple conversation messages
and a description of the parties in the conversation. The subject and each message is not
limited to one line (they can contain multiple lines).

Each message element can contain the following:

• Time stamp - the time format is ISO_8601. For example: '2013-12-04T18:26:46'
• Display name - the display name of the message sender.
• Party ID - the string identifier of the sender/party id. The party ID can be described in

two places, in both cases the ID will be used to match the party/speaker type. If the

Billing Issue

How can I help you today?
I want to change my billing address.
May I have your account number please?
...
It's been my pleasure to assist you today
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party ID cannot be found in one of these places it will be ignored and identified as a
different party in the call.

◦ In the 'speakers' element in the meta data xml file
◦ In the 'parties' element in the chtx file (see below)

Messages without a party ID or messages with a party ID that were not found, will be treated
as one party. This configuration is similar to the channels speakers configuration in dual
channel calls

Each party element can contain the following:

• Party ID - used to match the id from each 'message' element
• Party type - used to identify the type of the party/speaker when you configure

categories with speakers or limit the search in the web to specific speakers.

If one of these attributes are missing this party configuration will be ignored.

Important
The additional information in each message is not
mandatory.

The order of the messages in the file should be the
original order. Since it's not mandatory, the system
will not sort the messages according to the time
stamp value. If the sender name is not specified in
the message the system will not use the speaker
name from the speakers configuration (the UI will not
show any name)

File Format Examples

Example 1:

<?xml version="1.0" encoding="us-ascii"?>
<chat>
<parties>
<party partyId="FIRST SPEAKER ID" partyType="FIRST SPEAKER TYPE"

/>
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<party partyId="SECOND SPEAKER ID" partyType="SECOND SPEAKER TYPE"
/>

...
</parties>
<subject>SUBJECT LINE</subject>
<message time="FIRST MESSAGE DATE AND TIME" partyId="FIRST MESSAGE

SPEAKER ID" displayName="FIRST MESSAGE SENDER NAME">
FIRST MESSAGE CONTENT

</message>
<message time="SECOND MESSAGE DATE AND TIME" partyId="SECOND

MESSAGE
SPEAKER ID" displayName="SECOND MESSAGE SENDER NAME">
SECOND MESSAGE CONTENT

</message>
...

</chat>

Example 2:

<?xml version="1.0" encoding="us-ascii"?>
<chat>
<parties>
<party partyId="customer" partyType="customer" />

</parties>
<subject>Billing issue</subject>
<message time="2013-04-18T12:10:42" partyId="agent"

displayName="Agent 1"> How can I help you today?
</message>
<message time="2013-04-18T12:10:51" partyId="customer"

displayName="Customer 1"> I want to change my billing address
</message>
<message time="2013-04-18T12:10:58" partyId="agent"

displayName="Agent 1"> May I have your account number please?
</message>

...
<message time="2013-04-18T12:15:23" partyId="agent"

displayName="Agent 1"> It's been my pleasure to assist you today
</message>

</chat>
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Important
Any white space around the message content or
subject content will be removed (including the first
and last new lines). New lines inside the content will
be preserved. Since the format is XML, any reserved
XML characters need to be encoded if they appear in
the subject content, message content or attributes.
Any other XML information will be ignored

PartyID Configuration

PartyID Configuration

PartyID can be configured in two places:

• In the chat meta xml file, in the speakers element. The speakers element in the
meta xml file is used for mapping the interaction to an agent and work group. Since
speakerType is defined in the meta xml file, the file is used as part of the parties
configuration.

• In the parties element in the chtx file. The parties element contains parties that
are not linked to the interaction as agents or work group (for example, a customer).

The chtx fetcher will search for each PartyId used in the message in the speakers
configuration. If the PartyId does not exist in the speakers element, the chtx fetcher
will check the parties element. If the PartyId is not defined in both places the PartyId will
be ignored.

Example 1: 2 Parties (Agent + Customer)

In this example, the agent is defined as the speaker and the customer is defined in the
parties element.

Meta XML File:

<?xml version="1.0" encoding="us-ascii" ?>
<callInformation>
<mediaType>Chat</mediaType>
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<textFormat>XML</textFormat>
<textTime>2014-01-07T10:54:04</textTime>
<programID>english</programID>
<speakers>
<speaker id="ag1" speakerType="agent">
<workgroup>/W1/W2</workgroup>
</speaker>

</speakers>
</callInformation>

CHTX File:

<?xml version="1.0" encoding="us-ascii"?>
<chat>
<parties>
<party partyId="customer1" partyType="customer" />

</parties>
<subject>Billing issue</subject>
<message time="2013-04-18T12:10:42" partyId="ag1"
displayName="Agent 1"> How can I help you today?

</message>
<message time="2013-04-18T12:10:51" partyId="customer1"
displayName="Customer 1"> I want to change my billing address

</message>
<message time="2013-04-18T12:10:58" partyId="ag1"
displayName="Agent 1"> May I have your account number please?

</message>
</chat>

As shown in the above example the agent with ag1 ID is configured in the speakers
element, in the meta xml file and the customer with the customer1 ID is configured under
parties in the chtx file.

Example 2: 3 parties - agent, supervisor and customer

In this scenario there are two options. You can configure the supervisor as a speaker (the
common scenario) or as the party in the chat. When configured as the party a link to an
agent or work group is not possible.

Option 1: Supervisor as a speaker - Meta XML File
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<?xml version="1.0" encoding="us-ascii" ?>
<callInformation>
<mediaType>Chat</mediaType>
<textFormat>XML</textFormat>
<textTime>2014-01-07T10:54:04</textTime>
<programID>english</programID>
<speakers>
<speaker id="ag1" speakerType="agent">
<workgroup>/W1/W2</workgroup>
</speaker>
<speaker id="sup1" speakerType="supervisor">
<workgroup>/W1/Sup1</workgroup>
</speaker>

</speakers>
</callInformation>

Option 1: Supervisor as a speaker - CHTX File

<?xml version="1.0" encoding="us-ascii"?>
<chat>
<parties>
<party partyId="customer1" partyType="customer" />

</parties>
<subject>Billing issue</subject>
<message time="2013-04-18T12:10:42" partyId="ag1"

displayName="Agent 1"> How can I help you today?
</message>
<message time="2013-04-18T12:10:51" partyId="customer1"

displayName="Customer 1"> I want to change my billing address
</message>
<message time="2013-04-18T12:10:58" partyId="ag1"

displayName="Agent 1"> May I have your account number please?
</message>
<message time="2013-04-18T12:11:02" partyId="customer1"

displayName="Customer 1"> I want to talk to supervisor!
</message>
<message time="2013-04-18T12:11:03" partyId="sup1"

displayName="Supervisor A"> I'm the supervisor, how can I help
you?
</message>

</chat>
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Option 2: Supervisor is not a speaker - Meta XML File

<?xml version="1.0" encoding="us-ascii" ?>
<callInformation>
<mediaType>Chat</mediaType>
<textFormat>XML</textFormat>
<textTime>2014-01-07T10:54:04</textTime>
<programID>english</programID>
<speakers>
<speaker id="ag1" speakerType="agent">
<workgroup>/W1/W2</workgroup>

</speaker>
</speakers>

</callInformation>

Option 2: Supervisor is not a speaker - CHTX File

<?xml version="1.0" encoding="us-ascii"?>
<chat>
<parties>

<party partyId="customer1" partyType="customer" />
<party partyId="sup1" partyType="supervisor" />

</parties>
<subject>Billing issue</subject>
<message time="2013-04-18T12:10:42" partyId="ag1"

displayName="Agent 1"> How can I help you today?
</message>
<message time="2013-04-18T12:10:51" partyId="customer1"

displayName="Customer 1"> I want to change my billing address
</message>
<message time="2013-04-18T12:10:58" partyId="ag1"

displayName="Agent 1"> May I have your account number please?
</message>
<message time="2013-04-18T12:11:02" partyId="customer1"

displayName="Customer 1"> I want to talk to supervisor!
</message>
<message time="2013-04-18T12:11:03" partyId="sup1"

displayName="Supervisor A"> I'm the supervisor, how can I help
you?
</message>

</chat>
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